Full Circle
THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

ISSUE #1 22 - June 201 7

Base photo: ut4fp.org/page/getting-started

Manip (added UBports logo): Ronnie Tucker

I N STALL U B PO RTS TO U CH
FROM UBUNTU OTA-1 5 TO UBPORTS R1
full circle magazine #1 22

1

Fu ll Ci rcle M a g a zi n e i s n e i th e r a ffi li a te d wi th , n o r e n d o rse d b y, Ca n o n i ca l Ltd .

contents ^

Full Circle

HowTo

THE INDEPENDENT MAGAZINE FOR THE UBUNTU LINUX COMMUNITY

Linux News

p.04

Python

p.1 5

Intro To FreeCAD

p.1 7

Command & Conquer

p.1 1

Researching With Linux

p.32

Install UBports Touch

p.22

Linux Labs

p.35

My Opinion

p.38

Book Review

p.XX

Kdenlive

p.31

Review

p.36

Letters

p.40

KODI Room

p.XX

Inkscape

p.27

Q&A

p.42

Ubuntu Games

p.44

My Desktop

p.47

Graphics

p.XX

The articles contained in this magazine are released under the Creative Commons Attribution-Share Alike 3.0 Unported license. This means you
can adapt, copy, distribute and transmit the articles but only under the following conditions: you must attribute the work to the original author
in some way (at least a name, email or URL) and to this magazine by name ('Full Circle Magazine') and the URL www.fullcirclemagazine.org (but
not attribute the article(s) in any way that suggests that they endorse you or your use of the work). If you alter, transform, or build upon this work, you must distribute
the resulting work under the same, similar or a compatible license.

Full Circle magazine is entirely independent of Canonical, the sponsor of the Ubuntu projects, and the views and opinions in the magazine should in no way be
full circle magazine #1 22
2
contents ^
assumed to have Canonical endorsement.

ED I TO RI AL

This magazine was created using :

WELCOME TO THE LATEST ISSUE OF FULL CIRCLE.

A

s per usual we have some Python, FreeCAD, Inkscape, and Kdenlive. To round things off I've
written up a quick HowTo on installing UBports (formerly known as Ubuntu Touch) on your
devices. I have a Meizu MX4 phone and a BQ M1 0 tablet which both had Ubuntu Touch OTA-1 5 on
them. UBports have now released the first version of non-Canonical Touch: UBports r1 . Previously
it would have meant installing this to your device via the command line, but the UBports team
have now released a nice GUI that will do all the hard work for you. So, get your devices charged
up and ready to go. There are some changes though: the Today scope isn't part of the default
UBports, neither is Here maps (UBports don't have the license for that), but most of the familiar
stuff is there, or can be installed from either the (soon to close) Ubuntu Store, or via the installed
Open Store. Just remember that UBports is still very young and very much under construction.
A new series begins this month from SJ Webb (formerly of Chrome Cult) who is going to use
this new column (well, replacing his previous one) to discuss the medical research that he does
using Linux. Now, brace yourselves, it's not Ubuntu. It's Fedora! So this is probably the first nonUbuntu series in the history of FCM. No pressure SJ. No pressure.
Don't forget to keep in touch. Send in your comments to fill the Letters page, and your
desktop screenshots for the My Desktop section. Send it all to me, Ronnie, at:
ronnie@fullcirclemagazine.org.
The Full Circle WeeklyNews is still going, allbeit that I've missed a couple of
weeks due to work, but thank you to all those who download and listen.

All the best, and keep in touch!
Ronnie
ronnie@fullcirclemagazine.org
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Submitted by Arnfried Walbrecht

WPS O FFICE' S LINUX

DEVELOPMENT HAS BEEN
HALTED

U

sers looking for a Microsoft
Office clone on Linux will be
disappointed to hear that WPS
Office’s development on Linux has
been halted. The most recent build
for Linux was released almost one
year ago, with the most recent
version being v1 0.1 .0.5672 Alpha.
The fact that development had
stalled was raised after one
Twitter user reached out to WPS
Office to ask why there hadn’t
been a new release for a while. The
response came back saying that it
was "on a halt" and that it needs
“community builds”; there’s little
chance that community builds will
become a thing within the next
few months given that WPS Office
is not even open source, making
community maintenance
somewhat of a challenge.
In a follow-up tweet, WPS
Office did confirm that while the
focus right now is on mobile, they
will focus more on Linux towards

the end of the year. The response
came when a user asked if the
office suite will be made open
source.
Source:
https://www.neowin.net/news/wp
s-offices-linux-development-hasbeen-halted

D EBIAN GNU/LINUX 9
“STRETCH ” WILL SHIP WITH
N EW D IGITAL FORENSICS
TOOLS

L

ast week, we told you about
the announcement of the
release date of Debian 9.0 Stretch
GNU/Linux distro. According to the
announcement, Debian 9.0 is
slated to arrive on June 1 7, 201 7.
Prior to that, another exciting
development was made in the
Debian world in the form of
release of systemd-free Devuan
1 .0.0 distro.
Debian 9 GNU/Linux release is
supposed to ship with many digital
full circle magazine #1 22

forensics tools and their
dependencies. Spotted by
Softpedia’s Marius Nestor, the
announcement was made by
Debian developer Michael ‘mika’
Prokop.

OWN CLOUD CONFERENCE
201 7 ANNOUNCED FOR
SEPTEMBER 20-23 IN
N ÜRNBERG , G ERMANY

o

wnCloud Conference 201 7 is
an event targeted at
ownCloud developers and users
alike, and it looks like the
upcoming one is the fourth ever,
opening its gates on Wednesday,
He added that the packages will September 20, until Saturday,
be maintained by the Debian
September 23. Over 200 people
Forensics team. They’ll also be
from all the corners of the world
accompanied by their libraries.
are expected to attend the
conference.
Some of the digital forensics
tools shipping with Debian 9 are as
There, you will attend two days
follows:
of conference and three days of
• bruteforce-salted-openssl
hacking and hands-on, so no
• cewl
matter if you are an ownCloud
• dislocker
developer, contributor, reseller,
• pompem
hoster, admin, user, translator, or
• unhide.rb
even value-adder, you are
encouraged to attend oCCon1 7
Source:
this September for another round
https://fossbytes.com/debianof ownCloud hacking.
gnulinux-9-stretch-digitalforensics-tools/
Take a look at the official
website of the conference if you
want to learn more about how to
Prokop wrote: “Debian/stretch
AKA Debian 9.0 will include a
bunch of packages for people
interested in digital forensics.”
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get there, where to stay, etc., and
please try to keep in mind that the
call for sessions and sponsors is
now officially open. Registration
will also open in the coming days
for attendees, so bookmark the
event's page for upcoming details.

instead of the Folder Widget that
was used until now. Folder View
features spring loading
functionality which you can see in
action in the gallery below, spacesaving icon grid, unified drop
menu, and better mouse behavior.

Source:
http://linux.softpedia.com/blog/o
wncloud-conference-201 7announced-for-september-20-23in-n-rnberg-germany-51 61 46.shtml

Source:
http://news.softpedia.com/news/k
de-plasma-5-1 0-officially-releasedfolder-view-is-now-the-newdefault-desktop-51 61 27.shtml

KDE PLASMA 5.1 0
O FFICIALLY RELEASED,
FOLDER VIEW I S N OW THE
N EW D EFAULT D ESKTOP

PATCHES AVAILABLE FOR
LINUX SUDO VULNERABILITY

attacker with sudo privileges to
run commands as root or elevate
privileges to root.
An alert on the sudo project
website says SELinux must be
enabled and sudo built with
SELinux support for the
vulnerability to be triggered. Sudo
1 .8.6p7 through 1 .8.20 are
affected. Users should update
sudo to 1 .8.20p1 .
Source:
https://threatpost.com/patchesavailable-for-linux-sudovulnerability/1 25985/

R

ed Hat, Debian and other
Linux distributions yesterday B ODHI LINUX 4.2.0
pushed out patches for a highU BUNTU -BASED OPERATING
hen the Beta milestone
severity vulnerability in sudo that
SYSTEM NOW AVAILABLE
launched two weeks ago,
could be abused by a local attacker
KDE also unveiled all the features to gain root privileges.
odhi is an interesting Linux
they managed to implement in this
distribution thanks to its
major release, which will make its
Sudo is a program for Linux and lightweight nature. If you have an
way into the software repositories UNIX systems that allows standard
of your favorite operating system users to run specific commands as older PC that isn't particularly
powerful, the operating system
in the coming weeks, so you should a superuser, such as adding users
could breath new life into it. Unlike
already have an idea about what's or performing system updates.
some other distributions that are
new.
light on resources, Bodhi is not
In this case, researchers at
ugly -- its Moksha desktop
If not, let us tell you that KDE
Qualys found a vulnerability in
environment looks rather modern.
Plasma 5.1 0 packs Folder View as
sudo’s get_process_ttyname
I highly recommend giving the OS a
the default desktop interface
function that allows a local
try.
full circle magazine #1 22
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B

Today Bodhi reaches version
4.2.0. It is quite the boring release,
as there isn't much to it. It is
merely a rollup, incorporating
many of the updates that were
released since the previous stable
version, 4.1 .0. If you are already
running Bodhi and have been
installing updates, there is no
reason to bother -- this is more for
those that aren't already running
the OS.
Source:
https://betanews.com/201 7/05/31
/bodhi-linux-420-ubuntu/

LINUX B ITCOIN U SERS N EED
TO BE AWARE OF THE NEW
S AMBA VULNERABILITY

A

s is the case with any potential
cyber threat these days, it is
unclear what the impact will be
exactly. A new Samba vulnerability
has been discovered, which can
affect Linux distributions as well.
This means anyone who runs a
version of the Linux operating
system on their computer may find
themselves on the receiving end of
a major cyber attack. That is,
unless they take notice of
contents ^
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mitigation options available to
them.
More specifically, Linux and
Unix system are susceptible to a
Samba vulnerability, which could
result in attacks similar to the
global WannaCry ransomware
outbreak a few weeks ago. All
versions of Linux and Unix released
on March 1 , 201 0, and later are
vulnerable to this attack vector as
of right now. It is possible for
criminals to remotely exploit the
Samba vulnerability. Moreover,
hackers could upload and execute
payloads on the infected systems.
For the time being, it does not
appear there are any active
exploits available right now.
Source:
https://themerkle.com/linuxbitcoin-users-need-to-be-aware-ofthe-new-samba-vulnerability/

TOYOTA' S ENTERTAINING THE
IDEA OF LINUX IN CARS

T

he Linux Foundation's
Automotive Grade Linux
project is celebrating its first bigname user, after Toyota said it will

employ the OS in the 201 8 Camry
model it will sell in the United
States.

like Xen Embedded and
Automotive can let different
services run in nicely-isolated-andsecure virtual machines.

Automotive Grade Linux (AGL)
Source:
is an effort to create a cut of Linux
capable of being dropped into cars https://www.theregister.co.uk/201
7/06/02/toyota_camry_to_run_aut
with minimal integration hassles,
omotive_linux/
so that auto-makers and
manufacturers of in-car electronics
can all build to a common standard.
The Camry will use AGL in its
infotainment system, which is
where the project currently
focuses its efforts.
In future the project's
participants want the OS to handle
just about everything inside a car,
including the instrument cluster, a
heads-up-display, telematics
services, advanced driver
assistance systems and even
autonomous driving.

LINUX M INT 1 8.2 'SONYA'
BETA U BUNTU -BASED

OPERATING SYSTEM NOW
AVAILABLE FOR DOWNLOAD

T

oday, the upcoming version of
Linux Mint, 1 8.2 "Sonya,"
achieves BETA release. It is based
on Ubuntu 1 6.04 and uses Linux
kernel 4.8. You can download
either the Mate or Cinnamon ISOs
now. Yeah, it’s a pre-release
operating system so you should
proceed with caution, but
Car-makers should, in theory,
historically, these BETA releases
like that plan because it's clear that have proven quite stable -- you will
drivers increasingly expect all sorts probably be fine.
of assistance in the cabin, but if
those services come from multiple
The Linux Mint team is making a
devices it will increase cars' bill of big deal of improved Bluetooth
materials and therefore increase
support and settings (Blueberry) in
complexity. A single unit to handle Sonya, but I haven't experienced
all tasks is therefore advanced as
issues in that regard in the past.
more sensible, especially if efforts
full circle magazine #1 22
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More important to users will be
the improved Update Manager,
which now includes a new slick
help section. Also user-facing is the
LightDM display manager, which
offers a prettier login screen with
HiDPI support.
Source:
https://betanews.com/201 7/06/06
/linux-mint-1 82-sonya-beta/

CANONICAL O UTS M AJOR
LINUX KERNEL SECURITY
U PDATE FOR U BUNTU 1 7.04
AND 1 6.04 LTS

W

hile the kernel update for
Ubuntu 1 6.1 0 systems
patches buffer overflow
discovered in Linux kernel's trace
subsystem, which could have
allowed a local privileged attacker
to execute arbitrary code, it looks
like a total of 1 5 and 1 3 kernel
vulnerabilities were patched for
Ubuntu 1 7.04 and Ubuntu 1 6.04
LTS machines, respectively. For
Ubuntu 1 6.04 LTS (Xenial Xerus),
users will have to install the linuximage-4.4.0-79 (4.4.0-79.1 00)
kernel package on 64-bit and 32-bit
PCs, linux-image-4.4.0-1 01 8-aws
contents ^
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(4.4.0-1 01 8.27) on Amazon Web
Services (AWS) systems, and linuximage-4.4.0-1 01 4-gke (4.4.01 01 4.1 4) on Google Container
Engine (GKE) systems.
Additionally, you need to install
the linux-image-4.4.0-1 057-raspi2
4.4.0-1 057.64 kernel on Ubuntu
1 6.04 LTS for Raspberry Pi 2
systems and linux-image-4.4.01 059-snapdragon (4.4.0-1 059.63)
on Snapdragon processors. An
HWE kernel is also available for
Ubuntu 1 6.04.2 LTS users, namely
linux-image-4.8.0-54 (4.8.054.57~1 6.04.1 ).
On the other hand, if you're
running the Ubuntu 1 7.04 (Zesty
Zapus) operating system, you'll
need to install the linux-image
4.1 0.0.22.24 kernel packages on
64-bit and 32-bit machines, as well
as the linux-image-raspi2
4.1 0.0.1 006.8 kernel on Ubuntu
1 7.04 for Raspberry Pi 2
computers.
Source:
http://news.softpedia.com/news/c
anonical-outs-major-linux-kernelsecurity-update-for-ubuntu-1 7-04and-1 6-04-lts-51 6294.shtml

LINUX M ALWARE M INES FOR
CRYPTOCURRENCY U SING
RASPBERRY PI D EVICES

A

Linux trojan detected under
the generic name of
Linux.MulDrop.1 4 is infecting
Raspberry Pi devices with the
purpose of mining cryptocurrency.
According to Russian antivirus
maker Dr.Web, the malware was
first spotted online in the second
half of May in the form of a script
that contains a compressed and
encrypted application.
Experts say the initial infection
takes place when Raspberry Pi
operators leave their devices' SSH
ports open to external
connections.
Once a Raspberry Pi device is
infected, the malware changes the
password for the "pi" account.
After this, Linux.MulDrop.1 4
shuts down several processes and
installs libraries required for its
operation, including ZMap and
sshpass.
The malware then launches its
full circle magazine #1 22

cryptocurrency mining process and
uses ZMap to continuously scan
the Internet for other devices with
an open SSH port.
Once it finds one, the malware
uses sshpass to attempt to log in
using the username "pi" and the
password "raspberry." Only this
user/password combo is used,
meaning the malware only targets
Raspberry Pi single-board
computers.

Source:
https://www.bleepingcomputer.co
m/news/security/linux-malwaremines-for-cryptocurrency-usingraspberry-pi-devices/

FINALLY! U BUNTU 1 7.1 0
D AILY B UILDS U SING
GNOME D ESKTOP BY
D EFAULT

I

n the past couple of months, the
world of open source was
dominated by Ubuntu’s upcoming
switch from Unity desktop to
GNOME. Ubuntu boss Mark
Shuttleworth made this
announcement and said the
Ubuntu GNOME development
team will be merging with
Canonical’s Ubuntu Desktop team.
Last but not least, Dr.Web
Since then, people had been
researchers also said they
discovered a second Linux malware wondering about the future of
Ubuntu Desktop.
strain, which they named
Linux.ProxyM.
Well, after some wait and
As this malware's name implies, development work, the Ubuntu
1 7.1 0 daily builds are shipping with
this Linux trojan is used to start a
default GNOME desktop
SOCKS proxy server on infected
devices, which the trojan's author environment. This way, Ubuntu has
then uses to relay malicious traffic, finally ditched the Unity desktop in
the true sense, which had been the
disguising his real identity and
default choice since 201 1 .
location.
This is somewhat out of the
ordinary since most malware tries
to target as many platforms as it
can. Nonetheless, this version of
the malware may be still under
development, and other username
& password combos may be added
at a later date.
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At the moment, LightDM is the
Ubuntu display manager, but the
final version will ship with GDM.
LightDM has two sessions: GNOME
and GNOME Wayland. These builds
are early releases, so expect a few
bugs while trying them.
Source:
https://fossbytes.com/ubuntu-1 71 0-daily-build-gnome-default/

H OW TO USE LINUX' S BUILTIN USB ATTACK PROTECTION

T

here are USB sticks that will
destroy your computer, USB
sticks loaded with spyware, and
even official enterprise USB sticks
infected with malware. Last, but
never least, when it comes to
stealing data from a computer, you
can't beat a USB stick. There are
devices like the USG USB stick
firewall, which can protect you, or
if you're a Linux user, you can
always stop attackers armed with
USB sticks with USBGuard.
As anyone who's ever watched
a TV show with our heroes
sneaking out sensitive data from a
computer with a USB stick knows,

Windows and Macs are easy to
crack with USB-borne tools. In the
real world, Linux-based USB
distributions such live-boot Tails
makes this easy. USBGuard can
stop any such attack.

LINUX 4.1 4 WILL B E THE
N EXT LTS KERNEL B RANCH

I

n a Google+ post, Linux kernel
developer and maintainer Greg
Kroah-Hartman said that Linux
USBGuard, as current stable
kernel 4.1 4 will be the next LTS
Linux kernel maintainer Greg
kernel series. He asked for
Kroah-Hartman recently pointed
suggestions from the community
out, has been around for over a
and told that 4.1 4 will remain
decade. For some reason, this user- supported for at least two years. If
space tool, which provides access
the development process gets
control to USB devices, is not well completed at the regular pace, we
known. It should be. It's a great
can expect to witness the final
addition to anyone needing to
release in November. Last year in
protect a Linux desktop or server. August, we told you that Linux 4.9
was going to be the next LTS kernel
This software framework is
release. It arrived towards the
designed expressly to protect your November end and brought tons of
computer against rogue USB
new features and hardware
devices by implementing basic
support. That official
whitelisting and blacklisting
announcement was first made by
capabilities based on device
renowned Linux kernel developer
attributes. It enables you to lockGreg Kroah-Hartman.
down all USB devices from user
space.
Now, first spotted by Softpedia,
Greg has once again announced on
Source:
his Google+ page that the next LTS
http://www.zdnet.com/article/how kernel branch will be Linux kernel
-to-use-linuxs-built-in-usb-attack4.1 4.
protection/
In his post, Greg wrote: “As no
one seemed to make 4.9 blow up
too badly, let’s try this again! 4.1 4
full circle magazine #1 22
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== next LTS kernel.” He further
wrote that Linux kernel 4.1 4 will be
supported for at least 2 years.
Source:
https://fossbytes.com/linux-4-1 4next-lts-kernel/

U BUNTU 1 7.1 0 TO I MPROVE
SECURE B OOT FOR B OOTING
WINDOWS FROM GRUB,
AND E NABLE PIE

T

he first Alpha builds of Ubuntu
1 7.1 0 are almost here, due for
release next week on June 29,
201 7, for opt-in flavors, so the
Ubuntu developers are working
around the clock to add various
new features, such as PIE (Position
Independent Executables) support
enabled by default for better
security, as well as some other
improvements in many areas of
interest like Secure Boot.
PIE support is good news for
Ubuntu Linux users as all PIEenabled binaries will now be
automatically loaded into random
locations within the virtual
memory, along with all of their
dependencies, each time the
contents ^
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respective applications are being
executed. This makes Return
Oriented Programming (ROP)
attacks harder to execute properly.

D EBIAN 9 ‘STRETCH ’
GNU/LINUX D ISTRO
RELEASED

T

he Debian Release team has
finally released the Debian 9.0
“Stretch” stable GNU/Linux
distribution. Named after Toy
Story’s rubber toy octopus, Stretch,
this release will remain supported
for 5 years. Debian 9 ships with
Linux kernel 4.9, new digital
forensics tools, GNOME 3.22,
default MariaDB, etc. You can
either update your exisiting
installation or download the new
installation media from the
project’s website. Last month, we
reported about the Debian Release
Other than that, there's good
Team’s plans to ship the final
news for those who want to boot
Ubuntu Linux alongside a Windows release of Debian 9.0 “Stretch”
GNU/Linux distribution on June 1 7.
OS, as the Ubuntu developers are
working on improving Secure Boot Well, acting well on their promise,
they have shipped the new stable
chainloading so you'll be able to
version, i.e., Debian 9, code named
properly boot Windows from the
Stretch. For those who don’t know,
GRUB bootloader. Some patches
Debian codenames are based on
were also added so that u
the characters in the famous
animated movie Toy Story. This
Source:
http://news.softpedia.com/news/u release is named after the glittery
purple rubber toy octopus, Stretch.
buntu-1 7-1 0-to-improve-secureboot-for-booting-windows-fromAfter a combined effort of
grub-enable-pie-51 6534.shtml
Debian Security team and Debian
LTS team, this release will be
full circle magazine #1 22
Among other noteworthy
enhancements that are coming to
the Ubuntu 1 7.1 0 operating
system later this year, we can
mention the implementation of
Netplan, Canonical's consolidated
YAML network configuration
across Ubuntu, in the Ubuntu
Cloud images. Netplan is also
being used by default to configure
networks when installing an
Ubuntu Server via the Debian
Installer.

supported for the next 5 years. The
Release Team has also dedicated
this release to Debian founder Ian
Murdock, who passed away in
December 201 5.
Debian 9 could be easily called
one of the most important Linux
distro releases of 201 7 because in
the upcoming months, tons of
other distros will be based on it.
Source:
https://fossbytes.com/debian-9stretch-features-downloadtorrent/

CANONICAL WANTS TO ADD
H ARDWARE ACCELERATED
VIDEO PLAYBACK BY
D EFAULT TO U BUNTU

I

n his latest report, Canonical's
Will Cooke reports on the efforts
the Ubuntu Desktop team is
making to enable hardwareaccelerated video playback for the
upcoming Ubuntu 1 7.1 0 (Artful
Aardvark) by default.
According to Will Cooke, the
team's goal right now is to lay the

9

groundwork for a solution that
would enable hardwareaccelerated playback of video files
by default, with a focus on making
it work on Intel graphics cards.
Suppor for Nvidia and AMD
Radeon GPUs should come at a
later time thanks to Canonical's
new testing infrastructure.
The Intel SDK (Software
Development Kit) issue with the
LibVA library should soon be
resolved as Intel is currently
working on a fix. In related news,
Canonical announced that it will
soon unveil a call-for-testing
programme for Ubuntu, inviting
users to take part of small and
quick tests that they can regularly
perform for continued feedback on
the work done so far by the
Ubuntu Desktop team for the
upcoming release of the operating
system, Ubuntu 1 7.1 0.
This will help the Ubuntu
Desktop team and Canonical
ensure the overall quality of the
Ubuntu Desktop Live images is
kept high throughout the entire
development cycle, which will end
on October 1 9, 201 7, when the
final release of the Ubuntu 1 7.1 0
(Artful Aardvark) operating system
hits the streets.
contents ^
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Source:
http://news.softpedia.com/news/c
anonical-wants-to-add-hardwareaccelerated-video-playback-bydefault-to-ubuntu-51 6555.shtml

CANONICAL O UTS M AJOR
SECURITY U PDATES FOR ALL
SUPPORTED U BUNTU LINUX
RELEASES

with HWE kernel, linux-image
4.4.0.81 .87 on Ubuntu 1 6.04 LTS or
linux-image 4.8.0-56.61 ~1 6.04.1 on
Ubuntu 1 6.04.2 LTS with HWE
kernel, linux-image 4.8.0.56.69 on
Ubuntu 1 6.1 0, and linux-image
4.1 0.0.24.26 on Ubuntu 1 7.04.

The updated Raspberry Pi 2
kernels are linux-image-4.4.0-1 059raspi2 4.4.0-1 059.67 for Ubuntu
1 6.04 LTS for Raspberry Pi 2, linuximage-4.8.0-1 040-raspi2 4.8.0anonical released major kernel 1 040.44 for Ubuntu 1 6.1 0 for
security updates for all
Raspberry Pi 2, and linux-imagesupported Ubuntu Linux operating 4.1 0.0-1 008-raspi2 4.1 0.0-1 008.1 1
systems patching up to eleven
for Ubuntu 1 7.04 for Raspberry Pi
vulnerabilities across all of the
2. Again, please update your
supported architectures.
installations to the new kernel
builds as soon as possible.
Most of the patched kernel
vulnerabilities in these updates are
Source:
new, and they've been recently
http://news.softpedia.com/news/c
fixed upstream in the Linux kernel. anonical-outs-major-securityTherefore, it's now time for OS
updates-for-all-supported-ubuntuintegrators to update their
linux-releases-51 6567.shtml
repositories and keep users safe,
and Canonical is always known for
doing a great job releasing up-toSYSTEM 76 D EVELOPER
date kernels for Ubuntu.

C

After the update, check if
you're running linux-image
3.1 3.0.1 21 .1 31 on Ubuntu 1 4.04
LTS or linux-image-lts-xenial
4.4.0.81 .66 on Ubuntu 1 4.04.5 LTS

WORKS ON GNOME
ENCRYPTED H OME FOLDER
SUPPORT FOR U BUNTU
1 7.1 0

full circle magazine #1 22

S

ystem76's kernel engineer
Jeremy Soller announced that
he's been working on bringing
encrypted Home folder support in
the GNOME desktop environment
for the upcoming Ubuntu 1 7.1 0
(Artful Aardvark) operating
system.
Last month, the Denver-based
computer reseller specializing in
the sale of laptops, desktops, and
servers pre-loaded with the
Ubuntu Linux operating system
revealed their plans for preparing a
consistent GNOME experience for
their computers powered by
Ubuntu 1 7.1 0 later this year when
the OS launches officially.

the GNOME desktop environment
to be encrypted during the
creation of a new user, a
functionality that appears to be
implemented in the CreateUser Dbus call.
Source:
http://news.softpedia.com/news/s
ystem76-developer-works-ongnome-encrypted-home-foldersupport-for-ubuntu-1 7-1 051 6602.shtml

While not many were impressed
by the new Pop theme that
System76 wants to offer by default
for their Ubuntu 1 7.1 0 system with
GNOME desktop, some were
thrilled to learn that KDE Connect
will become a first class citizen to
provide users with seamless
notifications from their Android
devices.
And now you'll also be surprised
to find out that System76 plans on
allowing the Home directory on
new installs of Ubuntu 1 7.1 0 with
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CO M M AN D & CO N Q U ER H ow D o I Lea rn To Prog ra m?

Written by Lucas Westermann

B

• Look at some open source
projects on GitHub. You don’t need
to contribute, and you don’t need
to feel too comfortable with your
skills. Even just viewing someone
No. This article is geared
else’s source code can help you
towards my personal approach to
test your understanding (i.e. can
learning a language. I’ll refer to
some websites and books, but the you tell what the code does), as
well as seeing examples of things
actual learning of the language is
to do (or not do) with regards to
out of scope.
formatting and comments.
Lastly: Comment everything.
A FEW GENERAL POINTERS. •While
this is a terrific habit to build
up
if
you’re
planning to make this a
The following points apply to
anything you decide to learn, and is profession, it will also help you
immensely if you look at older
therefore in a separate section:
programs.
• Do not rely on autocomplete or
tools like Emmet too early on.
LOCAL
Once you’re comfortable writing
WHO IS THIS ARTICLE FOR? the code without a helper, feel free
There are a mass of local
to enable one to save time.
However, it is not supposed to be a programming languages - Python,
This article is geared towards
crutch when you forget the syntax. C++, Perl, and Java just to name a
anyone remotely interested in
few. There isn’t typically a “best
programming, but who is uncertain • Always try something new. Do
language”, although there are
not stick to the same program
about where to begin, or what
scenarios where some languages
format - even if you just work on
approach to take. This can be
improving the help menu in every are better suited for a particular
designers who feel they ought to
task. If you don’t know what
learn a little about HTML and CSS, program you write, or trying to
language to learn, there are a few
reduce any repetitions. You may
to budding computer enthusiasts
ways to decide. Either see what
who want to learn a programming struggle a bit, but it will help you
programmers in your local area are
learn.
language for future careers.
learning (via job postings), or see
full circle magazine #1 22
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eing a self-taught
programmer and web
developer, I frequently hear
questions like “how did you get
started?” or “how did you learn this
on your own?”. This month, I
thought that dedicating an article
on how I approach learning a
programming language might be a
good way to formulate my future
answers, and to encourage anyone
who has even a passing interest to
begin their journey. I will be
splitting this article into two
distinct sections - local (i.e.
programs to be run on your local
machine) and web (web apps,
websites, etc).

WILL THIS ARTICLE TEACH ME
A LANGUAGE?

what languages are supported by
your favourite devices (computers,
phones, RPi, etc). It can even be
something as arbitrary as liking the
logo.

THE APPROACH
Learning a local language will
typically require a bit more setup
than a web language. You’ll want
to find a good IDE or text editor
you feel comfortable in. An IDE is
very useful when learning
something like C++ or Java, as the
tools included can help you debug
issues early on. Personally, I prefer
a text editor, as it’s something I’ll
always have access to, instead of
relying on tools included in an IDE.
You’ll also want to set up a good
folder structure to keep your
source code, and possibly even
store it in a Git repository (or
something like Dropbox). That way,
you can recover previous iterations
of code, if necessary, or easily
carry it between devices.
Lastly, ensure you’ve installed a
compiler or interpreter for your
chosen language. Once you can run
contents ^
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it in a terminal or within your IDE,
you’re all set.

• • Can it do everything I plan to
achieve?
• If you answered yes (or even
• After you have your environment ‘maybe’) to these questions, you’ll
set up, look for any official
probably want to continue learning
tutorials/tours. These typically
the language. To do so, I’d
cover some basic ‘hello world’
recommend either finding some
programs. While the programs
need that you want to fill, or
themselves aren’t very creative,
finding a good website with
they help you learn the syntax and challenges, which you can
the way a language functions.
implement in your chosen
• Once you’ve completed the Hello language.
World program, try to branch out
• Here are a few things you may
into user input and/or commandalso want to focus on:
line arguments (depending on the • • Testing (writing tests, as well as
language). As the most useful
simply debugging issues).
applications require some form of • • Sharing/Compiling (i.e. how can
input, it’s useful to learn this early you package this program up to
on. I typically do this using the
putting it on a new computer).
official documentation of features, • • Storing information/data. This
as opposed to a full-fledged guide. can be done with databases, JSON,
• The next step should be to
or just normal text files.
branch out and learn some of the
• • Reading information.
oddities or strengths of your
• • Executing commands from your
language. You can typically find a
desktop or their
listing of these features by finding equivalents
a comparison of various languages.
• At this point, I always evaluate
the utility of the language. To do
so I ask the following questions:
• • Does this language suit the way
I think/work?
• • Is it in demand (i.e. in the
workplace)?
• • Can I live with any
drawbacks/oddities?
full circle magazine #1 22

(such as using ls to list files).
• • Regular expressions. Even just
learning a few standard regex for
searching strings or filenames will
be useful.
• Lastly: learn a new language! Or,
at least, stay up-to-date on the
new versions of your chosen
language. To keep your skills sharp
and your habits ingrained, you will
want to regularly try to learn
something new.

WEB
Web languages can be a bit
quicker to the starting line than
local languages. Using something
like CodePen or a JS Fiddle, you
can easily write some HTML, CSS
and JavaScript without having to
worry about an IDE or a hosting
solution. You should definitely not
work solely with this
approach, but if
you’re not
sure
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whether or not to devote time
here, it’s an easy way to try it out.
It may be confusing to see
HTML, CSS and JS in the first step
of my approach. You may be
wondering what’s left. There are a
variety of frameworks (bootstrap,
react, angular, etc) that offer more
functionality to the standard
HTML. There are also other
languages (such as Go, Python),
and expansions on JavaScript (such
as ECMAScript).
To set up your development
area locally, you’ll need a text
editor (you can also go for a
WYSIWYG (what you see is what
you get) program, but I would
really not recommend it).
Personally, I use the Atom text
editor. Beyond the text editor,
you’ll also want some sort of LAMP
stack (Linux Apache, MySQL, and
PHP). My recommendation is not
to install it on your main system instead, you can set up something
like Vagrant (a VM) or Docker (a
containerization tool). This is for
two main reasons - if you use
frameworks or tools like Node or
NPM, you can more easily control
the installed versions for optimal
support, and because Docker is
contents ^
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gaining massive popularity in the
workplace. Docker is also portable,
making it easier to carry your
projects over to a new computer.
I’ve previously written about
Docker in FCM#1 07. If you’re
looking at Python or Go, both offer
a local development server built
into the compilation tool. WebPack
(covered in C&C in FCM#1 20) also
offers a local development site for
working on HTML, JS and CSS.

previously had. If you begin a
project with the goal of supporting
older browsers, I would still
recommend beginning with the
modern tools, and then creating
either a fallback stylesheet, or
wrapping the modern code in
@supports. If you’re unsure what
the difference is between old
versions of HTML and HTML5, you
should look into the new elements
introduced in HTML5 (such as
<main>, <aside>, <footer>,
<header>).
THE APPROACH
• At this point, you should decide
on what language you’re focusing
• Learn HTML5, CSS and JS. You
on. If you just want to continue
don’t need to master JavaScript,
learning HTML and CSS, you may
but you do need a basic
understanding of it. Neither HTML want to look into CSS custom
properties, as opposed to finding a
nor CSS are terribly complex - the
preprocessor. You’ll also want to
moment you feel comfortable
creating a basic ‘hello world’ HTML look into something like Grunt or
Webpack to use autoprefixer,
page with a bit of styling, you’re
ready to carry on. This can easily be which will help reduce how much
CSS you have to write (see FCM
done in CodePen.
• The first step I would recommend #1 20 for my WebPack article). If
you decide to focus on a language
is learning the “modern web” like Python or Go, you’ll want to
HTML5 (which should have been
make sure you install it correctly
done in #1 ), @supports, Flexbox,
and can run the commands from a
and CSS Grids in CSS 3. The three
terminal. If you choose to learn
elements of CSS I listed are
PHP, make sure support is
currently supported in the most
enabled/installed on your system
recent versions of every popular
or Docker (using Apache or Nginx).
browser, and mitigate a lot of
Or perhaps you’re just interested
headaches that developers
in learning about AMP
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(Accelerated Mobile Pages) by
Google.
• You should begin with a tour or
tutorial on the language you’ve
decided upon. Depending on what
language you’re looking at, the
steps may vary.
• After the tour or tutorial, you’ll
want to see about integrating
what you learned about HTML and
CSS into the new language. In Go
and Python, this means
templating, and, in JS frameworks,
you’ll probably already be
integrating some of this.
• Content. Here you should focus
on how to get content into your
website or web app. This can be
databases, a content management
system, a static site generator
(such as grow or jekyll) or pulling
information from a feed (RSS or
JSON). If you use a content
management system, I would
recommend starting with an API
Content Management System
(such as Cockpit) first, as it can
help you understand how all CMS
systems work, as opposed to
jumping right into something like
WordPress.
• Testing. You should look at your
resulting website or web app on a
few different devices - phones,
tablets, computers, and varying
browsers. You’ll quickly
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understand how wide-ranging the
support is, and how many issues
can crop up. Don’t be disheartened
- you don’t typically need to
support every possible device, and
there are a variety of tools to help
you improve support.
• Lastly, deployment. You should
look into how you would go about
hosting your application, and also
how you would “go live”. This can
be FTP + Docker + DigitalOcean, or
Git + Heroku, or GitHub Pages +
Git. Every combination has its
strengths and weaknesses, which
is why you should do some
research to see what works for
your language choice.

D ESIGN
While the approach above
focuses on the programming
aspect, creating a visually
appealing site is largely dependent
on your design. At any time after
Step 2 in the approach above
would be an acceptable time to
start reading on design
approaches. Covering things such
as Material Design, or reading
articles from Smashing Magazine
or CSS-Tricks are a good place to
start. There are also a few books
that I highly recommend: Smashing
contents ^
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Book 5 (from Smashing Magazine)
is written by a variety of authors,
and is a terrific insight into
common design approaches. Also,
Hardboiled Web Design by Andy
Clarke (Fifth Edition) is an
excellent read on new
technologies, approaches, and tips
for creating modern websites.
Both are available in physical
copies, or digitally. Even just taking
the time to analyse source code on
websites you like is a terrific way
to learn - I would recommend
keeping either a local wiki or some
form of journal outlining things
you’ve seen that you would at
some point want to implement.
Naturally, if you’re not planning to
turn this into a job (or even put it
on your CV), you can choose to
ignore anything outlined here.

I hope this article proves useful
to anyone who was feeling
overwhelmed by the mass of
options and instructions to be
found on the web. When in doubt start with a basic ‘hello world’, and
then go from there! If you have any
tips you’d like to share, send them
to me at
lswest34+fcm@gmail.com. I will
collect any responses together
into an article at a later date. Feel
free to also email me with any

questions, suggestions, or ideas
for articles.

FURTHER READING
CodeFights (programming
challenges) https://codefights.com/home

C&C in FCM #1 21 - All about Go
C&C in FCM #73 - A basic
introduction to some websites for
learning to code.
Udemy (online library of paid
courses, frequently on sale) https://www.udemy.com

Project Euler (largely mathematical Udacity (online university that
offers micro degrees and some
programming challenges) free courses, in partnership with
https://projecteuler.net/
Google/Facebook/etc.) https://www.udacity.com/courses/
201 6/201 7 MUST-KNOW Web
all
Development Tech Video
(YouTube) https://www.youtube.com/watch?v
=sBzRwzY7Gk&index=7&list=PLQjv2GANsZ1 JA
Kzoz631 tlyIOZiJ3T2R6
CodeAcademy (website to learn
coding with free courses) https://www.codecademy.com/
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A short podcast (<1 0min)
with just the news. No chitchat. No time wasting. Just
the latest FOSS/Linux/
Ubuntu news.

RSS:

http://fullcirclemagazine.
org/feed/podcast

Code School (website to learn
coding, with some free courses) https://www.codeschool.com/
Videos/Workshops from Google
IO, the AMP Conference, or
Beyond Tellerrand (all found on
YouTube).

THE FULL CIRCLE
WEEKLY N EWS

Lucas has learned all he knows from

repeatedly breaking his system, then
having no other option but to
discover how to fix it. You can email
Lucas at: lswest34@gmail.com.
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P yth on I n Th e Rea l World - Pt 79

Written by Greg D. Walters

elcome back to our
‘Temp/Humidity via
Bluetooth’ project. As you will
remember, last month we got
everything working to a
smartphone. This month, we will
be working on getting things up
and running on the Raspberry Pi.
The first thing we have to do is
get the RPi Bluetooth connected
to the Arduino. I’m going to
assume that you already have the
proper bluetooth software
installed on your RPi. I’ve installed
bluetooth-5.23-2+rpi2, bluez-5.232+rpi2, bluez-firmware-1 .23+4rpi1 , pi-bluetooth-0.1 .3 and
pulseaudio-module-bluetooth-5.01 3 on my RPi3. I’m sure that some
of those are not needed for basic
bluetooth communications. There
are many places on the web that
can explain the process. Once you
get everything installed, connect
to your Arduino bluetooth device. I
had to use “1 234” during the
pairing process. I also marked it as
a trusted device.
Once we have it paired and
trusted, we need to do some

command-line magic to create a
virtual serial port named
‘rfcomm1 ’.
In a terminal type:
hcitool scan

You should see something like:
pi@raspberrypi:~ $ hcitool
scan
Scanning ...
98:D3:31:30:49:B1
HC-06
pi@raspberrypi:~ $

The big thing you should take
away from this is the mac address
of the bluetooth device (hopefully
the arduino) that you are
connected to. You will be using this
address in the next command.
Now, type:
sudo rfcomm bind /dev/rfcomm1
98:D3:31:30:49:B1

Where the 98:D3:31 :30:49:B1 is
the mac address of the bluetooth
H05/06 module on the Arduino
that was obtained from the hcitool
command above. Yours will be
full circle magazine #1 22

different, so use it.
Now in the terminal type:
rfcomm

Again, you should see
something like this:
pi@raspberrypi:~ $ rfcomm
rfcomm1: 98:D3:31:30:49:B1
channel 1 clean
pi@raspberrypi:~ $

local echo is
noinit is
noreset is
nolock is
send_cmd is
receive_cmd is
imap is
omap is
emap is
crcrlf,delbs,

:
:
:
:
:
:
:
:
:

yes
no
no
no
sz -vv
rz -vv

Terminal ready

This will allow you to send a “T”
for temperature, an “H” for
humidity, or an “A” for both.

You will have to repeat most of
This tells you that you now have
this process each time you reboot
an open serial port into the
the RPi. I made a shell script that
Arduino bluetooth device.
contained those lines so I could run
it as needed.
Finally, in the terminal type:
sudo picocom -c /dev/rfcomm1

In the terminal, you should see:
rfcomm1: 98:D3:31:30:49:B1
channel 1 clean
picocom v1.7
port is
flowcontrol
baudrate is
parity is
databits are
escape is

15

:
:
:
:
:
:

/dev/rfcomm1
none
9600
none
8
C-a

However, this series is about
using Python, so, next, we’ll write a
simple program to communicate
with our Arduino.

A SIMPLE TERMINAL
PROGRAM
Below is a very simple program
in Python that will allow us to
communicate to the Arduino via
contents ^
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the serial port.

change depending on the
command we send, that option
if ser.isOpen():
The first three lines import the
isn’t really a good one without a
print(ser.name + ' is
open...')
pyserial library and set up the port.
lot of work. We also could have
used the ser.readline() command,
import serial
Now comes the meat of the
but that only reads up to the CRLF
program.
We
start
a
“forever”
being sent in, so while good for the
port = "/dev/rfcomm1"
loop,
sending
out
a
prompt
to
baud = 19200
“T” or “H” command, the “A”
enter a command or to enter ‘exit’ command which sends two lines,
The next line uses only some of to quit, and wait for input from the would have some problems. The
the parameters available since the user. This works perfectly for our
timeout value we set earlier is
purposes,
since
the
Arduino
is
also
others aren’t needed. The
important, since the system would
waiting
for
a
command.
It
also
important one is the timeout
block until the CRLF is returned.
parameter. If we set the timeout to allows us to terminate the
else:
program properly.
“none”, the system will wait
forever (blocking) until the
ser.write(cmd.encode('ascii')
while True:
specified number of characters
+'\r\n')
cmd = raw_input("Enter
out = ser.readlines()
have been received in the .read
command or 'exit':")
for l in out:
# for Python 2
command. If we set the timeout to
print l
# cmd = input("Enter
0, the system will return
command or 'exit':")
immediately, returning 0 or more
# for Python 3
The source (short as it is) is
if cmd == 'exit':
characters from the port. We,
available on pastebin at
ser.close()
however will set the timeout to 1
https://pastebin.com/tXWirGCX
exit()
second. You can specify the
number of seconds for the system
So, that’s it for this month.
Now that there is something in
to wait and you can use a float
We’ve successfully created the
the cmd variable, we encode it to
value.
ascii, append a CRLF to it, and then Temp and Humidity sensor circuit
write it to the serial port. We then and are now able to read its values
ser = serial.Serial(port,
use the ser.readlines() command to with a remote Raspberry Pi using
baud, timeout=1)
get the data from our Arduino. We Python.
actually have several options here
In the next two lines (plus the
We’ll see you next month.
comment), we are simply verifying to read from the serial port. If we
had
used
ser.read(),
we
would
have
the serial port is open and then
had to specify the number of bytes
printing that fact.
to be received. Since that can
# open the serial port
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Greg Walters is owner of RainyDay

Solutions, LLC, a consulting company
in Aurora, Colorado, and has been
programming since 1 972. He enjoys
cooking, hiking, music, and spending
time with his family.
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I n tro To FreeC AD - Pt3

Written by Alan Ward

In this series, we will be
examining the world of FreeCAD,
an open-source CAD modelling
application that it still in Beta, but
has been gaining acceptance in
recent years. Naturally, it is readily
available in the Ubuntu
repositories. In the second article
on using FreeCAD, we created a
simple planar object to illustrate
the use of the main workspaces
(Draft and Part), drawing tools, and
extrusion.
In this part, we will use further
tools to create a more complex 3D
object, representing a Y-junction

between two pipes of different
diameters. This project is actually
quite involved from the standpoint
of technical drawing, since at one
point we will be representing the
intersection between two curved
surfaces - which always makes for
interesting shapes as any pipe
welder can testify to.

ROLLING A PIPE
Let us begin with the section of
thin-walled pipe shown here. All
dimensions are in millimeters. In
this example, total length is 1 20
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mm, with an initial flared section
30 mm long on the inside and 35
mm outside. The shell is 3 mm
thick along most of its length, with
a slightly thicker section where the
flare meets the main tube body.
This is done with a gradient of 1 :2
both inside and outside. Finally,
the main tube body has an inner
diameter of 40 mm, while the flare
goes out to 50 mm internal
diameter.

outside shell of our solid object in
3D. Likewise, the inside edge of
the wall (in dotted lines) may also
be revolved around the same axis,
giving us the inner shell of our 3D
object. In essence, we will be using
a similar tool to the extrusion used
in the last part of this series, but
running around a circle instead of
moving in a straight line.

To design this part, I could have
begun within the Draft workbench
What is particularly interesting of FreeCAD, and drawn each line
about this piece is the axis of
section needed to complete a
revolution shown in dashed gray: if section of the tube wall. However, I
we take the outside edge of our
actually started out with LibreCAD.
object and make it revolve around As discussed previously, the
this axis, we will be creating the
LibreCAD application is best suited
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to drawing objects in two
dimensions, which is why FreeCAD
had been preferred as a base tool
for this series. However, LibreCAD
does have an option to export
drawings in the widely-used DXF
(AutoCAD) file format, which can
then be imported into FreeCAD
and used as a basis to work with.
Since the lines are already
correctly positioned, it may be
advantageous to use this scheme
to set up our FreeCAD object.
In FreeCAD, begin by starting a
new project. Now choose menu
option File > Import

rotated. In the Draft workbench,
examine the Combo view on your
left, and you will see each
individual line from the DXF file,
that can then be erased, moved, or
modified, as needed.
When we are satisfied, as
before, we will need to combine
the collection of Lines into a single
Wire object with the “join objects”
tool in the modification toolbar
(whose icon is the blue up arrow).
Select all segments, either in the
combo view or in the drawing itself
- holding down the Ctrl-key to

select multiple objects - and use
the join tool. In the combo view,
we will see the four segments
disappear, to be replaced by a
single Wire object.

Be sure to select the X axis to
rotate around, since the tube
object is symmetrical about this
horizontal axis. Also, activate the
“Solid object” checkbox. This will
allow us to use this part as a
To create the actual 3D tube,
complete object further on, and to
let us move to the Part workbench. make holes in it to allow branching
Now choose the “Rotate object”
with the lateral piece of pipe.
tool from the 3D toolbar.

ADDING A LATERAL PIECE OF
PIPE IN A Y-JUNCTION

We are now going to add a
small piece of pipe, with inner
diameter 20 mm and outer 26 mm,
attacking our existing tube at an
angle of 45 degrees. The axis of

Now, we have several more
elements than are needed for the
tube wall. The axis needs to be
removed, as well as the (previously
dotted) lines denoting rotated
edges. The lower copy of the wall
section will also be erased, leaving
just the higher copy, ready to be
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the new pipe will intersect our
existing axis at 1 00 mm along its
length.

shapes to form it.

will both appear in the same
position, as “Cylinder” and
Let us begin by hiding the
“Cylinder001 ”. Default
existing tube. This is done by going characteristics are a radius of 2
There are several ways of
to the Combo view on the left,
mm and height of 1 0 mm.
creating this new piece of pipe. We selecting the Revolve object, and
could proceed as before, drawing
hitting the space key on the
the outline with Line segments and keyboard. It will not remove the
then rotate the piece to create a
tube from our project, but simply
3D revolution solid. This can be
make it invisible - thus making the
created aligned with one of the
construction of the smaller tube
standard axes, for example the Y
easier to visualize.
axis, and then moved into position
as required. However, since the
Now, using the Primitives
shape of the new piece of pipe is
toolbar visible in the Part
rather straightforward, it may be
workbench, let us create two
easier to use pre-existing primitive cylinders. For the time being, they
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Now, using the Combo view on
the left, choose the first Cylinder
and go to the bottom tab marked
“Data”. Here, change the radius to
1 3 mm and the height to 1 00 mm.
This will be the solid material for
our new tube.
Choose the second Cylinder,
and do the same, giving it radius
1 0 mm and height 1 04 mm. This is
the shape we will cut out from the
first cylinder, making it hollow.
However, as in the part created in
the last article of this series, both
cylinders end at the same Zcoordinate. This means FreeCAD
can have difficulties calculating
exactly where the cutout is to end.
To make things more clear, let us
move the second cylinder
downwards by 2 mm, making it
protrude slightly from each end of
the first cylinder. This is done by
editing Placement > Position > z in
the same tab, and giving it
negative value -2 mm.
We will now use the second
cylinder to cut a hole in the first. In
the Combo view, choose in
sequence the first cylinder, then
the second, holding down the Ctrlkey when choosing the second
object. Then, choose menu option
Part > Boolean > Cut, and the two
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cylinders should be combined into
a single hollow tube using
Constructive Solid Geometry.

vertical and needs to be tilted to
45 degrees, while the larger
Revolution object has been placed
at some distance from the
coordinate system’s origin for
some reason, perhaps related to
the use of a DXF file to import its
basic shape.

We are ready to assemble the
two parts of our project. Go back
to the Combo view, choose the
Revolution object - the main tube and press the space key. Both
objects should become visible at
To tilt the Cut object, go to the
once, with a bit of zooming.
Combo view, select this object,
However, the new Cut object is still choose the Data tab as before, and

unscroll Placement. We need to
change the Axis values to [0.00,
1 .00, 0.00] since we will be rotating
around the Y axis, and then change
Angle to -45 degrees to tilt the Cut
object backwards to our left.
Now select the Revolution
object, and modify Placement >
Position > x value until the two
parts are assembled in their
correct position. I needed to
specify -200 mm for this to
happen.
We still have a couple of
problems, however. The small pipe
is protruding through the wall of
the main tube, but it is not yet
cutting a hole in that wall. On the
other hand, there is a piece of the
small pipe within the large one
that also needs to be cut off.
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The easiest solution for the first
bit is simply to undo our boolean
cut operation by simply clicking on
the Cut object in Combo view, and
deleting it. We should now have
three objects in our project: the
Revolve object representing the
large tube, Cylinder as the outer
shape of the small pipe, and
Cylinder001 the inner shape of the
cutout. The two Cylinder objects
will need to be rotated once more
to -45 degrees along the Y axis,
since the rotation we had applied
previously concerned the
combined Cut object which we
have since erased.
Now, add a third Cylinder object
- labelled Cylinder002 - to
represent the interior of the large
tube. It should have radius 20 mm,
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height 1 24 mm, be rotated on Axis
[0.00, 1 .00, 0.00] (the Y axis) by +90
degrees, and then placed to the
left by 92 mm by changing Position
> x value to -92 .
Finally, we can join the two
external objects, Revolve and
Cylinder, in a single Fusion object:
choose Revolve, then Cylinder with
the Ctrl-key pressed, and finally
menu option Part > Boolean >
Union. This should create a new
object called “Fusion”. Now, do the
same with Cylinder001 and
Cylinder002, creating “Fusion001 ”.
At this point, we should see only
the two Fusion objects, one
representing the material we are
adding to our project, and the
second representing the cutout or
material we will be subtracting.
Now choose these two objects in

order: Fusion, then Fusion001 , and
choose Part > Boolean > Cut. We
should end up with our final,
finished tube Y-union. We can note
the shape of the union between
the two tubes.
This technique of combining all
the bits of our project that add
material into a single Fusion
object, and all cutouts into another
before making the final Cut, can
come in useful when designing
parts with complex CSG
geometries. The general workflow
is similar to that used in Sketchup,
which should mean making the
transition from one program to the
other is rather painless.
Once completed, our object can
be cut open as needed to examine
the interior geometry and the
full circle magazine #1 22

section of each
piece, for
instance to make
sure there is
enough material
to support any
structural or
pressure stresses
that the finished
part may
encounter. This
cutting open is
left as an
exercise to the
reader. Hint: try
Part > Boolean >
Intersection with
another object.

WHAT NEXT?
In this article on using FreeCAD,
we used several techniques to
create a complex 3D object,
representing a Y-junction between
two pipes of different diameters.
The Revolution tool was used to
create the form of a tube in 3D,
from a plane section of the tube
wall. The Cylinder primitive was
used to create the form of the
small pipe attached to the main
tube, and then to create cutouts to
empty out both forms. In the next
part of the series, we will
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investigate the use of sketches to
implement constraints on segment
placing.

Alan holds a PhD in Information and
the Knowledge Society. He teaches
computer science at Escola
Andorrana de Batxillerat (highschool). He has previously given
GNU/Linux courses at the University
of Andorra and taught GNU/Linux
systems administration at the Open
University of Catalunya (UOC).
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Written by Ronnie Tucker

s many device holders will
know, Canonical has
discontinued Ubuntu Touch and
this means our devices would sit
dormant with no future updates.
Not so! UBports have come to the
rescue, and will continue to
maintain Ubuntu Touch for all
official devices which came via
Canonical, and the devices that
UBports ported Touch to. The full
list (as of writing) is:
Nexus 5
Meizu Pro 5
Meizu MX4
Fairphone 2
BQ M10 HD
BQ M10 FHD
BQ Aquaris E5
EQ Aquaris E4.5
So is there anything you need
to do? Yes. You need to flash your
device to the UBports version of
Touch. This is quite painless and
has been made moreso by the
release of the UBports Installer
software.

WARNING! Flashing your device

I n sta ll U Bports (U bu n tu Tou ch)
x86_64.AppImage to your system.

will completely erase it and install
Once it’s finished downloading,
a new OS. Be sure you have backed
up any necessary files before doing you need to check that it’ll
execute. Right click on the file and
anything else.
(in the menu) go to Properties.
There should be a tab for
D EVELOPER M ODE
Permissions. Click that, and you
should see something along the
Before we continue, it’s usually lines of ‘Allow executing file as
best to put your device into
‘Developer Mode’. You do this by
going into System > About >
Developer Mode. In this screen,
you’ll see a switch for Developer
mode. Slide the switch to make it
show green. A popup will appear at
the top of the screen asking if you
want to allow/disallow this. You
need to allow it.

program’. Check the little box
beside that. Close that Properties
window. Now you can double click
on the file to run it.
On first run, you’ll see the app
window. It has a dropdown menu
of the supported devices and is
displaying ‘Waiting for device…’ at
the bottom.

D OWNLOAD
The first thing you need to do is
download the installer. This is done
via:
https://github.com/ubports/ubport
s-installer/releases. If you want to
compile source code, you can, but
for this I’ll be using the AppImage
version. Save the file ubportsinstaller-0.1 .4-betafull circle magazine #1 22
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up/down volume keys, I selected
FASTBOOT
fastboot and pressed the power
The device has to be in
‘fastboot’ mode. Getting the
device into Fastboot mode is
different for each device. For my
BQ M1 0 FHD, I had to turn off the
device then hold down volume-up
and power. This took about 5 or 6
seconds before the device came on
with the white screen. I let the
buttons go, and up came a menu
with several options. Using the

button. That put the device into
fastboot mode. For the Meizu MX4
(that I’m going to use for this
tutorial), it was volume-down and
power. Again, it took a few seconds
before the device reacted and it
went straight to fastboot mode.
No menu.

small white text at the bottom
saying ‘=> FASTBOOT mode… ’

FLASH ! AH -AAA!
With the device in fastboot, it’s
time to plug in the USB cable. I
chose the MX4 from the list and
clicked select. If your device is in
developer mode, it will auto detect
the device for you.

1 5.04/stable. You can choose to
install the rc, or developer,
channels, but I’m sticking with
stable. Now I click install.
The installer will remind you
that you’re about to factory-reset
and lose all data. Click install as
long as you don’t mind losing all
data on the device.

You’ll know when the device is
Now the installer asks for a
in fastboot mode as the screen will
The app agrees that it is an MX4 password. This is your desktop
be blank apart from some very
root password. Enter that and click
and is now ready to install

full circle magazine #1 22
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OK.

You’re off!
After Touch had downloaded,
the flashboot text at the bottom
of my MX4 changed (I couldn’t
manage to get a photo of it) and
the phone rebooted with the
Ubuntu logo on the screen and the
installer changes to say that it’s
downloading more files.
All the while, my MX4 sat there

with the purple wallpaper and
white Ubuntu logo.
After downloading all the files,
the installer will begin pushing the
files to the device.
Now, remember how I said
you’d lose all your data? Well, you
probably won’t. Most times,
flashing UBports Touch doesn’t
wipe the device. I threw in that
disclaimer JUST IN CASE it does
happen. Maybe future installers
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will wipe
the caches
and so on.
For now?
They don’t.
The
device will
reboot
showing
the ever
familiar
Ubuntu
loading
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screen, but
(after a
while) it’ll
change to
show the
UBports
loading
screen.
Going
into System
Settings >
About it
should say
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Ubuntu 1 5.04 (r1 ).

Done! This device is now using
the UBports Touch.
What I did next (on my MX4)
was to go into System Settings >
Reset, and do a factory reset to

remove all the old apps and data. I
don’t want to end up with a device
that has UBports OS but with
Ubuntu Store apps. Remember: the
Ubuntu Store will close soon.
UBports has its own OpenStore
that is installed with the OS.

H ELP:
UBports Telegram Supergroup:
https://t.me/ubports
UBports forum:
https://forums.ubports.com
UBports bug tracking:
https://wiki.ubports.com/wiki/UBp
orts-Bug-Trackers

Ronnie is the founder, and editor, of
Full Circle. His other interest is art,
and his work can be seen at:
ronnietucker.co.uk
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Written by Mark Crutch

ne area of functionality that
has received a huge boost in
0.91 and 0.92 is finding and
selecting objects. There are many
situations in which you may need
to find similar, or identical objects
in a busy drawing, perhaps to
delete or change them all at once.
In previous versions, this was a
chore, especially if you had to
make the same selection multiple
times. So let’s look at the various
ways in which recent releases
make this easier. I’m going to use
this contrived grid of objects to
give you a feel for how the new
tools operate:

The first few items all live under
the Edit > Select Same submenu,
and offer several different ways to
select all items which share a
particular visual style. To use any
of them, you must first select one
or more objects whose close
relatives you wish to also select. As
a first example, if I select the teal
square at the top left of my grid,
then use Edit > Select Same >
Object Type, all the other squares
are selected. In my image I’ve given
the selected items a gold colored
background to make them stand
out a little better, but you won’t
see that in normal use.

One important thing to note is
that selecting the same “object
type” purely refers to the type of
underlying Inkscape object – so
squares and rectangles, or circles
and ellipses, are considered
equivalent. You can see this effect
if I select the green star on the top
line, then use Select Same > Object
Type. Not only are the stars
selected, but so are the triangles,
as they were all created using the
‘star’ tool.

Frustratingly, the select by type
option doesn’t work terribly well
with multiple items selected. If
every object in the selection is
full circle magazine #1 22
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already the same type, it will work
to select the other objects of that
type; but if any one of them is of a
different type then, rather than
selecting all the objects of either
type, everything is de-selected
instead.
Select Same > Fill Color has no
such problem: if I have both the
teal square and the green star
selected, then all the objects with
a teal or green fill will be selected
by the command.

Note, however, that selecting
by color is extremely specific: it
will only select items whose fill
contents ^
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color is absolutely identical to your
starting object. There’s no way to
set a threshold, in order to select
all the items with approximately
the same shade of green, for
example.
There’s also a Select Same >
Stroke Color option, which does
the same thing, with the same
exacting requirements for a match,
but based on the stroke color
rather than the fill color. For
example, selecting the teal square
once again (before executing the
command) will select all the shapes
on the top and bottom rows; they
all have a black stroke, even
though the stroke thickness and
dashes are different between
them. Once again, starting with a
multiple selection will result in a
cumulative set of items whose
stroke colors match any of the
objects in your initial line-up.
The counterpoint to selecting
by stroke color is to select by
Stroke Style. This matches objects
only if they have the same stroke
thickness and dashes – including
the same dash offset, which seems
a little strict, in my opinion. Stroke
color, line caps, join type and
markers don’t seem to have an
effect, whereas the mitre limit

does. The choice of what
properties do and don’t contribute
to a “matching” line style seem
rather arbitrary and counterintuitive, which may limit the
usefulness of this option in many
situations.

<text id="text1178">
<tspan
id="tspan1180"
style="font-style:normal;
font-weight:bold;
font-family:Arial;

referred to as ‘attributes’. In the
<text> node, for example, the
id="text1 1 78" is an ‘id’ attribute,
with a value of “text1 1 78”. The
‘style’ attribute is a little special –
it holds CSS style data, which itself
takes the form of a list of
‘property:value;’ pairs.

Even more limiting, however, is
-inkscape-fontthe Select Same > Fill and Stroke
With that information in mind,
specification:'Arial Bold';
menu entry. This will match items
let’s take a look at the
fill:#000000;"
only with an identical stroke, but
Find/Replace dialog, with its
where both the fill and stroke
Options section expanded:
x="320.68646"
colors also match. It’s the digital
y="86.745667">
equivalent of a club doorman not
This is some text
only refusing entry for wearing
</tspan>
sneakers, but actually only
allowing entry to people with
</text>
exactly the same shoes as him, in
the same color and style – and only
XML represents a tree structure
then if they’re also the same size.
in text. Here you can see that we
have an opening <text …>
The next tool we’ll look at this
element, which gets closed by the
month is the recently souped-up
</text> line at the end. Inside of
Find/Replace dialog, which can be that is a single <tspan …> element,
opened from the Edit menu or by
again being closed near the end.
pressing Ctrl-F. The key to working Inside that is the text itself, “This is
with this dialog effectively is to
some text”. This is between the
understand that all it’s really doing opening and closing <tspan> tags,
is a search (and possibly a replace) but is not a tag itself. This piece of
of text within the XML code that
literal text is what XML refers to as
makes up an Inkscape document.
a ‘text node’, whereas <tspan> and
So, first, a quick recap on XML
<text> are ‘element nodes’. The
using a heavily abridged snippet of element nodes also have
code representing a text object in name=value pairs of extra data,
Inkscape:
full circle magazine #1 22
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As you might expect from a
Find/Replace dialog, the first two
fields allow you to type in text to
be searched for and, optionally,
text to replace it with. The search
will match against substrings,
unless the ‘Exact Match’ checkbox
is ticked, so searching for “Fred”
will match against Fred, Freda,
Winifred and Alfred – although the
latter two will match only if the
‘Case Sensitive’ checkbox is
cleared. Interestingly, you can
search with this field left blank. As
you might guess, an empty string
matches against everything, but
the match is further restricted by
the choices in the ‘Object types’
section at the bottom. Usually you
would probably leave this set to
‘All types’, but, by setting specific
checkboxes and leaving the search
field blank, it provides a fast way
to select all the objects of specific
types – a workaround for the
Select Same > Object Type’s
restriction on finding only one
type at a time.

as ‘Properties’ in the Inkscape UI).
Use the former to search and
replace text content – handy if
you’re using Inkscape as a poorman’s desktop publishing program
(though I do recommend that you
learn how to use Scribus if you
need to do any significant text
layout work). Use the ‘Scope’
buttons, and the checkboxes in the
‘General’ section to limit your
search a little, if necessary.

unable to get it to work at all on
my test file. Use a ‘Style’ search
instead.
• Attribute Value – Search within
the values of attributes. This
includes searching the values of id
and style attributes, even if the
earlier checkboxes are blank.
• Attribute Name – Search for
elements with a particular
attribute name. Not as useful as
searching for values.

visible any longer. If you search for
“#ff0000” hoping to select all the
elements with a red fill, you’ll also
select the object with no stroke.
Although it might not be visible,
there will still be a color stored for
the stroke in the style attribute,
which is enough for it to become
part of your selection.

The second warning is with
regard to the ‘replace’ field:
performing a find and replace in
text mode is generally safe; doing
Switching the ‘Search in’ control
Usually, searching for an
so in properties mode could have
to ‘Properties’ provides a great
attribute value is sufficient. It will unforeseen results. Thankfully,
deal more power, if you’re
find matching IDs, styles and font Inkscape is sensible enough to stop
comfortable enough with the
you performing a replace
insides of an SVG file to know what names, without you having to
operation if the ‘Attribute name’
to look for. By ‘Properties’ it means understand how they’re stored in
the XML. Only if it finds too much, checkbox is selected, but
attributes and attribute values,
including CSS properties. Making a is it worth switching to search only arbitrarily replacing strings within
IDs or styles. Searching for
attribute values can be almost as
distinction between these terms
attribute names is never really
destructive. It might seem safe
might seem a little petty, but
necessary for normal users, but
enough to replace your black fills
understanding them is key to
might have its place if you’re using with white, by searching for
making effective use of this
Inkscape to work on graphics for a “000000” and replacing it with
section of the dialog. There you’ll
web application that carry
“ffffff”, but a series of six zeroes
find checkboxes to tell Inkscape
additional custom metadata.
could easily appear in the
which parts of the XML it should
coordinates of your objects, where
search:
Assuming the more common
There are a couple of things to hexadecimal values are an error
• ID – Only search the value of the
case, where a search string is
beware of when using this dialog in that could break your entire
‘id’ attributes.
entered, the ‘Search in’ radio
• Style – Search for CSS properties ‘Properties’ mode, however. Firstly, drawing. If in doubt, save a backup
buttons determine whether the
it can end up selecting objects you of your file first.
and CSS values within the value
XML text nodes will be searched,
didn’t expect. Consider an element
part of ‘style’ attributes.
or the attributes on the element
with a red stroke; later you change
Having used the previous tools
• Font – Presumably this searches
nodes (though the latter is labelled for only CSS font names, but I was the stroke width to zero, so it isn’t to make a selection, Inkscape now
full circle magazine #1 22
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also provides a way to save that
selection for later use. The Object
> Selection Sets… menu item
opens a rather empty dialog for
managing stored collections of
selections:

The most important thing to
note about this dialog is that the
“+” button at the bottom does not
create a set containing your
current selection. Instead it
creates a new, empty selection set
which has another “+” button next
to it. Only when you click this other
button will your selection be
stored in the set. The same button
can be used later to add another
selection to any existing items in
the set.
If you click on the triangle next

to a set, hoping to view the
elements within it, you’ll quickly
find that there’s a rather useless
intermediate level, labelled
“Items”, that you also have to
expand. If you click the triangle
next to the “Items” entry to
expand it, you’ll finally get to a list
of the objects in your selection.

Clicking on the cross next to an
item in the list will remove it from
the set. Clicking on a name in the
list will select it, whereas clicking
on the Set itself will select all the
items in that set. Unfortunately,
clicking on a Set doesn’t highlight
all the items within it, so, if you
want to re-select all the items
except one, for example, you have
full circle magazine #1 22

to highlight each entry separately
whilst holding the CTRL-key. You
can even use the CTRL-key to
select multiple Sets, or
combinations of Sets and
individual items. What you can’t do,
however, is select something from
this dialog, then add to (or remove
from) the selection by CTRLclicking on objects on the canvas,
which is a pity as it effectively
turns Selection Sets into a separate
selection mechanism rather than
something which integrates
seamlessly into your normal
Inkscape workflow.
Selection sets are preserved
when you save a document,
however they do get cleared when
the Edit > Clean Up Document
menu is used. Nevertheless, they
have their uses – for example, as
another means to work around the
restriction on Select By Type only
working with a single type at a
time. If you want to select, say, all
the circles and rectangles, you
could use the Select By Type
option twice, adding each resultant
selection to the same Set.
The new and extended
selection tools in 0.92 are a
welcome addition, especially when
working with complex documents.
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They do have their limitations and
idiosyncrasies, but hopefully they’ll
continue to mature in future
releases to provide even more
capabilities.

Mark uses Inkscape to create three
webcomics, 'The Greys', 'Monsters,
Inked' and 'Elvie', which can all be
found at
http://www.peppertop.com/
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Written by Ronnie Tucker

nother quick one this month,
but it’s an important one:
colour correction.

Colour>LumaLiftGainGamma

Inevitably, at times, your video
will be dark (again, I’m looking at
you, mobile phone users!) and will
need some colour, and/or
brightness adjustments.

LUMA LIFT/G AIN /G AMMA
First, as ever, add a video to the
timeline.
Right click on it and go to Add
Effect >

There’s a similar, but different,
option under Colour Correction,
but I prefer this one.
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I won’t go into what each slider
does, as you’ll see the results when
you move the slider (or change the
numerical value), but the Gamma
slider will enhance the colour of
your video. The other two will
effectively adjust the brightness
and contrast.
So now you know how to get
your video files looking much
better. The tricky bit is trying to
get all those video files looking the
same throughout the video
without one being brighter/darker
than the previous one.
Unfortunately, I don’t have a fix for
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that, but my advice is to try and
keep the same lighting in your
scenes when making the video in
the first place. That will save time
in the long run, effectively
eliminating this step altogether.

Ronnie is the founder, and editor, of
Full Circle. His other interest is art,
and his work can be seen at:
ronnietucker.co.uk
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Written by S. J. Webb

data. After collecting the data, I
then process it and hand it off to a
bio-statistician for statistical
analysis. I use Linux on a daily basis
for my various research studies.

y occupation is a research
coordinator. I am essentially
a project manager in the clinical
research realm. My expertise
focuses on instrumentation for
osteopathic manipulative medicine
(OMM). Before I start talking about
my career and Linux, I need to
describe osteopathy.
Osteopathy is the sublime art of
treating physical somatic
symptoms using various
techniques of counterstrain, strain,
and therapeutic palpatory
treatment. This treatment is called
OMM. Osteopathy is a fairly young
medical science developed by A.T.
Still in the United States. He
believed the human body can heal
itself if the musculoskeletal
framework is balanced. In the
United States, osteopathic doctors
are considered equal to medical
doctors . Today, some osteopathic
doctors employ OMM to treat their
patients. However, worldwide the
standards for osteopathic
practitioners are varied. In some
countries, they are family doctors
or they are equivalent to physical
therapists. I work with primary

investigators in developing new
teaching methods or research
questions using OMM. To quantify
the scientific capabilities of OMM, I
use instrumentation to answer
various research questions.
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Instrumentation is simply the
term used to describe cutting-edge
technology to collect data. At my
university, I use motion capture
systems and pressure pads to
objectively collect and quantify
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There are a number of Linux
variants directed towards research.
Ubuntu has a variant called Ubuntu
Sci. I started using Scientific Linux.
It was originally based off Fedora
or Redhat Enterprise Linux. Today,
it is based off CentOS. CentOS is a
great LTS distro, however the
software packages are older and
stable. I prefer having newer
software in my daily distro.
I use a Fedora Remix that is
called the Korora Project. There
are a number of reasons I use
Korora. It is downstream from
Fedora, so updates are
implemented easily. It implements
media codes not supported by
Fedora. The tools I need from
Scientific Linux are available. My
old mentor, Mike Ferarri, uses
Fedora, so I have support if I break
my system. Luckily the
documentation for Fedora is
thorough. The Korora Project does
contents ^
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not support a forum, but there’s an
activity thread for help via this
Engage link, or you can access their
IRC Channel. The volunteers are
very quick in helping new users. If
you want to be involved in helping
a distro, consider contacting the
Korora Project. The Korora Project
team members are largely based in
Australia, so a time delay may
apply.
The main tools I use for my job
are varied – like my daily job
duties. As a research coordinator, I
have recruited individuals for
clinical studies, written
manuscripts, collected data sets,
processed data sets, managed

projects, trained new hires, done
basic statistical analysis, edited
videos, taken photographs,
encrypted files, and other duties as
needed. Fedora has the basic tools,
while Korora fills in the gaps. I use
Kdenlive, LibreOffice, GIMP, R,
Gnuplot, Veracrypt, Planner, and
other tools. I will cover these items
from a rpm perspective, however I
will include instructions for
Debian-based distros when
needed.

are Fedora Spins. The Fedora Spins
would be equivalent to Kubuntu,
Lubuntu, and Xubuntu. It is from
these Spins the Korora Project
enables XFCE, Cinnamon, MATE,
KDE, and Gnome. I originally used
Gnome, but my hardware barely
supported it.

commands. The software center is
in transition for the non-Gnome
desktop environments. For a
number of years, Yum Extender
was the graphical software center,
now it is being transitioned to
DNFdragora, which will be released
in future Korora editions. Yum
Extender is a dead project, and
DNFdragora is the new
replacement.

I employ the MATE DE. This is
the default layout as seen below
left. They use Plank on the left side
of the display, which is reminiscent
In the upcoming months, I will
of Gnome. It comes loaded with
peek into the various ways I use
Before getting into the tutorials LibreOffice, Firefox, and the
Linux in my job.
on the various programs I employ, standard fare of programs that
let’s do a short review of the
appear on most Linux Distros
Korora OS. The default DE for
today. If a person uses Ubuntu
Fedora is Gnome, however there
MATE, then using Korora MATE
would be an easy transition.
However, there are some key
differences between Ubuntu and
Korora. The installation process is a
bit of a bump using the Anaconda
Installer by Fedora. You have to
reclaim your hard drive space, and
then approve it. Ubuntu has an
easier installer. The command-line
interface is very different, using
sudo dnf install

versus
sudo apt-get
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SJ Webb is a researcher coordinator.
When he is not working, he enjoys
time with his wife and kids. He
thanks Mike Ferarri for his
mentorship.
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Written by Ronnie Tucker

G UIDELINES

T

he single rule for an article is
that it must somehow be

document.

REVIEWS

• Images should be JPG, no wider
than 800 pixels, and use low
compression.

G AMES/APPLICATIONS

linked to Ubuntu or one of the
many derivatives of Ubuntu
(Kubuntu, Xubuntu, Lubuntu, etc). • Do not use tables or any type of
bold or italic formatting.

RULES

• There is no word limit for articles,
but be advised that long articles
may be split across several issues.
• For advice, please refer to the

Official Full Circle Style Guide :

http://url.fullcirclemagazine.org/7
5d471
• Write your article in whichever
software you choose, I would
recommend LibreOffice, but most
importantly - PLEASE SPELL AND

GRAMMAR CHECK IT!

• In your article, please indicate
where you would like a particular
image to be placed by indicating
the image name in a new
paragraph or by embedding the
image in the ODT (Open Office)

If you are writing a review,
please follow these guidelines :
When you are ready to submit
your article please email it to:
articles@fullcirclemagazine.org

TRANSLATIONS
If you would like to translate
Full Circle into your native
language please send an email to
ronnie@fullcirclemagazine.org and
we will either put you in touch with
an existing team, or give you
access to the raw text to translate
from. With a completed PDF, you
will be able to upload your file to
the main Full Circle site.
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When reviewing games/applications please state clearly:
•
•
•
•
•
•
•

title of the game
who makes the game
is it free, or a paid download?
where to get it from (give download/homepage URL)
is it Linux native, or did you use Wine?
your marks out of five
a summary with positive and negative points

H ARDWARE

When reviewing hardware please state clearly:
•
•
•
•
•
•
•

make and model of the hardware
what category would you put this hardware into?
any glitches that you may have had while using the hardware?
easy to get the hardware working in Linux?
did you have to use Windows drivers?
marks out of five
a summary with positive and negative points

You don't need to be an expert to write an
article - write about the games, applications
and hardware that you use every day.
34
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Written by Charles McColm

U pg ra d i n g a n d D own g ra d i n g Pa cka g es

https://lornajane.net/posts/201 6/p virtualized PHP software packages,
one of which was PCRT, the other
hp-7-0-and-5-6-on-ubuntu
Owncloud. Because it seemed the
simplest route to get PCRT
sudo add-apt-repository
ppa:ondrej/php
The plan was to migrate the
installed, we installed Ubuntu
existing database and v2.2 of PCRT sudo apt update
server 1 4.04. But that turned out
to our newly spun virtual server, do
to be a mistake because Owncloud
sudo apt install php5.6
all the necessary upgrades to get
wanted a later version of PHP (5.59
to version 4.1 , then tackle backups. sudo a2dismod php 7.0
was installed; it needed 5.6).
As it turned out, we were regularly
sudo a2enmod php5.6
backing up the database and
In this case, I employed the
software, but as hinted, the
same
tactic, but ran a2dismod for
sudo service apache2 restart
installation didn’t go so smoothly
version 5.59 and a2enmod for 5.6.
on the new server.
Better planning might have
Of course this wasn’t the only
foreseen this problem, but often
answer, there were a number of
The
problem?
Ubuntu
1
6.04
time is precious and I end up
Our original “Repair Tracker”
PHP 5.6 dependencies I also
server. More accurately, the newer needed to install, but they all got
having to figure out issues as we
was running smoothly to this
version of PHP on Ubuntu server
go. Two separate virtualized
point, but there were several
sorted out by reading the error
and PCRT 2.2 didn’t seem to jive
environments would have also
problems:
logs during the install of PCRT.
well
together.
Luckily,
one
of
our
solved this problem, and it’s the
• We were using a fairly outdated
direction we’re headed, but it just
version of PCRT (v2.2 when 4.1 was sysadmins had run into a similar
All of this could have been
issue with other software. The
out).
avoided if we just installed Ubuntu got me thinking that it’s a bit of a
solution was to run an older
• The “server” we were running it
server 1 4.04 and used the version pain having to maintain several
version
of
PHP
(we
ended
up
with
versions of PHP to run the
on wasn’t in as secure a location as
of PHP default with it, however
two versions of PHP installed with one of our goals was to be as upsoftware we want to run.
most of our other servers.
the older active). Lorna Jane
• We weren’t even sure we had
to-date as possible, and, when I
Mitchell (author of PHP Web
Technologies like Docker
regular backups (we had a “dd”
took this approach on another
Services
and
PHP
Master)
also
ran
suddenly
seem more viable, even
backup that was old, so we could
development machine, it also
restore the machine if we needed into this issue and documented
didn’t quite work out as expected. for a smaller organization.
which PPA she used to install both
to, but we wouldn’t have recent
versions of PHP, I just reversed the
data).
On that development machine
second
last
step:
• We’ve started to virtualize more
we wanted to run a number of nonfull circle magazine #1 22
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everal months ago, I migrated
one of the software packages
we use at work to a new server.
Getting time to focus on
something as large as a server
migration is rare for me since I
usually have a bit less than 6 hours
a week to look into anything new.
In this instance, I was familiar with
the software package, PCRT (PC
Repair Tracker), but the migration
was both a change in hardware and
updated software - what could
possibly go wrong?

servers and this was another
physical machine that could break
down.

R E VI E W

E

E tc h e r

Written by Paul Romano

tcher is a cross-platform GUI
application to flash OS images
to SD cards & USB drives, safely
and easily. The OS images can be in
the format of .iso, .img or .zip files.
It was originally released on 5 April
201 6, and on 1 2 May 201 7 version
1 .0.0 was released.
From the web site: “Etcher is a
powerful OS image flasher, built
with web technologies to ensure
flashing an SDCardor USB drive is a
pleasant andsafe experience. It
protects you from accidentally
writing to your hard-drives, ensures
every byte ofdata was written
correctly, andmuch more. ”
More specifically... Etcher is
hard-drive friendly. It makes drive
selection obvious to avoid wiping
your entire hard-drive(s). After
flashing, it goes on to validate the
burnt image, so that there is no
more writing images on corrupted
cards and wondering why your
device isn't booting.

Supported Operating Systems
• Linux (32-bit & 64-bit) - most
distros

• Microsoft Windows 7 and later
(32-bit & 64-bit)
• macOS 1 0.9 and later

I NSTALLATION
The downloads for Linux are
provided from the home page in a
zip file of the AppImage package
format. AppImages are selfcontained runtimes that do not
require manual installation or root
(but do require you to give them
the necessary permissions to run
as a program). They will run on
pretty much every distro out there
— just download, and double-click
to run. (This paragraph originally
from OMGUbuntu).
Alternatively, if you have a
Debian or Ubuntu based distro,
you can install Etcher from the
command-line by:
Save the following as
/etc/apt/sources.list.d/etcher.list
(this is a one-line command):
deb
https://dl.bintray.com/resinio/debian stable etcher
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Trust Bintray.com's GPG key
(also a one-line command):
sudo apt-key adv --keyserver
hkp://pgp.mit.edu:80 --recvkeys 379CE192D401AB61

below refer to the screenshots.
The interface is very easy to
use:

Update and install:
sudo apt-get update
sudo apt-get install etcherelectron

The etcher-electron package is
68.4 MB.

U NINSTALL

In the top rjght-hand corner are
two icons. The question mark takes
you to the Help Page. The gear
icon takes you to a simple Settings
screen.

sudo apt-get remove etcherelectron
sudo rm
/etc/apt/sources.list.d/etche
r.list
sudo apt-get update

U SE
I have used Etcher to burn
images to only USB sticks. Until I
get one, I will leave it to the
Raspberry Pi users out there to try
it with SD cards. The numbers 1 -7
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Back on the main screen, click
on the left-most icon (a plus sign)
and select the image (.iso, .img or
.zip) that you wish to burn:
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REVIEW - ETCHER

a script. However, you are warned
that the CLI version is currently
experimental and to proceed with
caution.

Plug in your USB stick and it is
After a few minutes the screen
automatically recognised,
will change to show that the flash
unmounted if necessary, and ready is complete.
to be flashed.

CONCLUSION

I have been happy burning
images to USB sticks using the
command-line. However, this is a
multi-stage process. Firstly, many
distros automatically mount USB
sticks so you must find out what
device the stick is identified as, and
then unmount it. Secondly, you
must remember to prefix the dd
command with sudo and then
enter your password. This dd
command has the potential for
Click on the right-most icon to
T
O COME
disaster. If you incorrectly identify
start the actual flashing. The bar
your output device, you could
changes to indicate progress.
According to the Etcher
easily destroy data on a hard-drive.
website, future improvements will Thirdly, to verify the integrity of
include 50% faster burns, and
the files, you can:
simultaneous writing for multiple
• Boot from the newly flashed
drives.
device and hope there is an option
in the boot menu to check the files.
Or
ETCHER CLI
• You have to mount the device,
Also released at the same time look for a file called MD5SUMS,
SHA256SUM.txt or something
When flashing is completed, the as version 1 .0.0 was a commandsimilar, and then decide what is the
burnt image is validated and again line tool that aims to provide all
the benefits of the Etcher desktop appropriate command to verify the
progress is indicated.
application in a way that can be run integrity.
from a terminal, or even used from
full circle magazine #1 22
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In comparison, Etcher does all
of the above automatically and
easily. I think Etcher is worth
keeping an eye on, especially if it
can reach its goals of faster burns
and simultaneous writing for
multiple drives. A persistent
storage option would be nice as
well.

REFERENCES
Home Page: etcher.io/
GitHub: github.com/resin-io/etcher
Help Page: github.com/resinio/etcher/blob/master/SUPPORT.m
d
Review:
www.omgubuntu.co.uk/201 7/05/h
ow-to-install-etcher-on-ubuntu
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MY O PI N I O N

Sn a p py

Written by Adam Eveleigh

means that users are faced with
significant bugs which they should
never have had to deal with. It’s
impossible to test properly for
these occasions because, in order
to get the updates out as fast as
possible, the testing period is very
short—which means less time to
catch the bugs, and less time to
make patches to fix them. You may
think that this is possible, but
reality has shown that it is not. On
pressing those who claim that
Why is installing an
distributions like Arch, Antergos
automatically and fully updated,
and Manjaro are stable, you find
properly stable application on
Linux not currently possible? Well that actually they have to do
this is a big problem on the current various package management and
configuration tasks, which an
Linux desktop. There’s an
ordinary end-user should not have
apparently unresolvable dilemma
to do. Further, updates to
between having stable
applications and having up-to-date dependencies on these rolling
applications. This arises due to the distributions can break key
features of the desktop which
nature of the Linux desktop’s
shared dependency system. If you should never be broken, not just
applications. Antergos broke
have fully up-to-date
LightDM for at least a few hours
dependencies all the time—i.e., a
(possibly more if it was a while
rolling-release distribution
model—you may find that you end between when the bug occurred
and when the developers filed a
up breaking slightly older
blog post on it). If millions were
applications that haven’t been
using the Antergos operating
updated upstream to work with
system, this would have resulted in
the newer dependencies. This
nappy allows you to install an
automatically and fully
updated, properly stable
application on any distribution that
supports it. This currently includes
Ubuntu, Fedora, Arch, Debian,
openSUSE and Gentoo. Snappy
applications can even be installed
from the graphical software
center, if the software center
supports it.
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a great many unhappy users.
So much for the rolling-release
model. As for the release-based
distributions, they have the
opposite problem. They may not
be able to install a newer
application because they rely on
and expect a newer dependency
that isn’t yet in the distribution –
so they get bugs that way. If you
update the dependency, you risk
introducing bugs into other
programs that depend on the
same dependency, and this is why
PPAs on Ubuntu, for example, can
be quite risky and why packages
aren’t always kept completely upto-date by default in the first
place.
So how do we get properly upto-date applications that work
without these dependency-related
bugs? Well, you allow the
developer to bundle the
dependency versions that they
expect! This means that an update
to a dependency does not result in
users being left with a broken
application; the developer of the
application can update the
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dependencies and their
application, ensuring that it still
works correctly, in their own time.
Snappy adopts this approach.
There are still a few shared
dependencies like libc, but much
less than there were previously.
At this point, people complain
about the file size. The file size
does now increase because you
have multiple copies of the same
library used on the operating
system. This is probably the only
real disadvantage of snappy, but
there are several reasons why this
is not as big an issue as it seems.
Firstly, with delta updates, once
you have a snap installed, your
computer downloads only a small
amount of data to update the
snap. Secondly, the file size of
individual snaps can be cut down
by stripping out unneeded
features of dependencies, like
Peek has done with ffmpeg and
imagemagick. Thirdly, there’s
usually quite a lot of a hard drive
space on today’s laptops and
desktops, so a big file size isn’t too
much of an issue. Finally, there is a
precedent for this way of handling
contents ^

MY OPINION

packages: Android, for example,
which has many duplicate Jar files,
and even macOS and Windows, to
a lesser extent.

code editors, can do so, this is
called Classic confinement, but the
vast majority of snappy
applications are confined properly.

There’s another big advantage
of snappy that makes it worth
using: background updates happen
without a prompt, like in
ChromeOS, so there is less user
interaction and users can just get
on with using their operating
system. Could this mean that an
update breaks the app without the
user’s permission? Perhaps, but
this is less likely because there’s
few shared dependencies and
updates can be rolled back if
necessary. Perhaps this seems
insecure? But the applications are
confined, they don’t have access to
your whole system (they can if
they need to – if they use classic
confinement, but these snaps are
manually reviewed before entering
the snappy store), so this is not
really a problem. Indeed, the
confinement of snaps is itself
another reason why snappy is
great. They’re confined Androidstyle, they have access to only
certain parts of the system, not
the entire filesystem like with
Linux applications packaged
traditionally. Programs that really
need to access the filesystem, like

Snappy would make regular
application updates on desktop
Linux very easy for the end user,
and will continue to result in a
better end-user desktop
experience as development on the
format continues. But snappy is
also excellent for developers
writing desktop Linux applications.
They need to write only one
declarative snapcraft.yaml file to
build a snap of their application,
and only a couple of commands (or
even a couple of clicks) to get it
published on the snappy store and
thus published on every Linux
install which has snappy installed –
with no packager middleman.
Despite the possibility of having no
packager middleman, nonprogrammers like myself can get
involved by helping upstream
developers out by creating
snapcraft.yaml files for them to
adopt. Just go to the snapcraft
(the name of the tool which makes
snaps) tutorial, complete it (20
mins), then go and complete more
snapcraft tutorials if you wish (like
for Python, and websites), find a
program that hasn’t been snapped
full circle magazine #1 22

yet, and snap it, then forward the
working snapcraft.yaml to the
developer to use themselves. If
you face problems along the way,
you can check out the snapcraft
documentation, and you can ask
questions to the friendly snapcraft
community on the forums, Rocket
Chat, and Stack Overflow.
This is our opportunity to solve
an old problem with the Linux
desktop and drastically improve
the usability of that desktop for
ordinary computer users. Let’s
grasp that opportunity.
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LE T TE RS
SHOULD LINUX DROP 32-BIT
SUPPORT ?

I

don't think that it is a matter of
"should" or "shouldn't", but
rather of what is helpful.

If you would like to submit a letter for publication, compliment
or complaint, please email it to: letters@fullcirclemagazine.org .
PLEASE NOTE: some letters may be edited for space.

for certain distros, such as
Lubuntu, Puppy, Android, and so
forth, to continue providing both
32-bit and 64-bit.

I realise that this is more work
for the people who create these
products, so naturally we cannot
For modern distributions
insist that they do so. However, I
designed for modern machines,
hope that they will manage to have
e.g. Ubuntu, Mint, Kubuntu,
the resources to continue to
Fedora, Red Hat, and so forth —
support both 32-bit and 64-bit, at
even Xubuntu — it has come to the least for the next (say) five years –
point where supporting 32-bit
until the relevant hardware
machines makes no sense. What
becomes so cheap relative to
32-bit machine has the RAM and
today that replacing old devices
CPU to support them?
becomes viable for the poor.
However, there are still many,
Paddy Landau
many older devices in use
throughout the world, and I'll bet
that in poorer areas, replacing
them is not the cheap option that
it would be for those living in a rich P YTHON 2. X TO 3. X?
society. Think about what is
'm beginning to learn
probably the most popular Linux
programming and I thought
distribution on Earth: Android. The
about Python. Recently I found Full
old 32-bit smartphones will
probably be around for at least the Circle, but I had some issues why
try to apply, and when I asked I
next five or six years!
found out that the code in the
For their sakes, we still need 32- magazine is for an older version, so
I thought that if I asked you to
bit support. It would be welcome
full circle magazine #1 22

I

make a new update for the 3.6
version, I may be lucky and have an
answer. I'll be grateful.

Ahmed EB-BANA
Greg replies: All the code from
the early versions was producedfor
Python 2.x. After a while, I triedto
stick to code that wouldsupport
versions 3.x as well as 2.x.
Not all code, however can easily
support both major versions of
Python. This is the reason for so
many libraries not being available in
3.x.
The usual culprits are the print
statements since Python 3
REQUIRES the statement to use
parens. Try converting:
print x

to
print(x)

(in other words, try to enclose
the statements following the word
"print"in parens.)
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Join us on:
goo.gl/FRTMl

facebook.com/fullcircle
magazine
twitter.com/#!/fullcirclemag
linkedin.com/company/fullcircle-magazine
ubuntuforums.org/forum
display.php?f=270

FULL CIRCLE N EEDS YOU !
Without reader input
Full Circle would be an
empty PDF file (which I don't
think many people would find
particularly interesting). We
are always looking for articles,
reviews, anything! Even small
things like letters and desktop
screens help fill the magazine.
See the article Writing for Full
Circle in this issue to read our
basic guidelines.
Have a look at the last page of
any issue to get the details of
where to send your
contributions.
contents ^

LETTERS
There is one other thing you can
try, There is a conversion utility that
is includedwith Python 3.x which is
called2to3. I briefly touchedon this
in part 16 ofthe series which was in
FCM#42.

U PDATING THE KERNEL

I

have recently acquired a Lenovo
yoga 300. It is a nice laptop
which lacks some power, but
Xubuntu runs well on it and it does
well for general stuff and image
editing which is my thing. I like to
use LTS versions of Ubuntu.
Xubuntu 1 6.04 uses kernel 4.8
which lacks some drivers for this
machine, the main one being for
power and battery information and
management. I read that it is easy
to change kernels but, not having
done that before, researched it a
bit carefully. I tried the app for
kernel management which some
recommend as the easy way to do
it but that failed. So I downloaded
kernel 4.1 0.1 1 from
http://kernel.ubuntu.com,
following the instruction to
download the header files and the
kernel.deb files. Then a sudo dpkg
-i *.deb did the magic.

After a reboot the battery tools
were working in the XFCE taskbar. I
have done some extensive testing,
and, so far, everything seems to
work very well on this hardware.
Yet another win for Linux I say.
I know that 1 7.04 has the 4.1 0
kernel but I did not want to
reinstall unless I had to, and now I
should be able to run 1 6.04 on this
hardware through to the next LTS.
These are the great things about
Linux, and the community who
share information out so that
people like me can benefit. So
thanks for all the work you do, it is
appreciated. Full Circle is a great
magazine which I look forward to
receiving.

Iain Mckeand
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Q &A

If you have a Linux question, email it to: misc@fullcirclemagazine.org , and
Gord will answer them in a future issue. Please include as much
information as you can about your query.

Compiled by Gord Campbell

How can I change where
Q Cheese
saves the pictures it

debian package from Canon.

For the MG6300 series drivers, I
would start at the Canon Asia
website http://support-asia.canonYou might need to install
asia.com/?personal and that takes
dconf-editor.
me to http://support-asia.canonasia.com/contents/ASIA/EN/01 004
When I run dconf-editor, I can
70702.html and you get
go to org/gnome/cheese/photoscangearmp-mg6300series-2.00-1 path. I toggle "Use default value"
and enter "Pictures" as the Custom deb.tar.gz
value.
So that is a debian package,
compressed
into a tar.gz format. It
Sure enough, Cheese saves
is a 5yr old driver; if you were to
images in my Pictures folder.
click to download and select SAVE,
it should end up in your Downloads
folder. Commands to install; one
line at a time, and hit ENTER after
I'm having trouble running
each paste, would be:
scangearmp on Linux Mint
1 8.1 . I'm using a Canon mg6320
cd Downloads
and would like to get the scanner
going.
tar -zxvf scangearmptakes?

A

Q

A

(Thanks to pdc in the Ubuntu
Forums) For quite a few years
now, Canon has supplied drivers in
3 formats for Linux users: rpm
packages, debian packages, and
source code. Mint uses Ubuntu;
Ubuntu uses Debian, so debian
packages are used; so just use a

mg6300series-2.00-1deb.tar.gz

cd scangearmp-mg6300series2.00-1-deb
./install.sh

and then to run it the command
would be:
full circle magazine #1 22

scangearmp

drive has started
Q toMyfailprimary
SMART testing, running

afoul of the "reallocated sectors"
problem. Since this device has the
UEFI boot sector, and three
operating systems on it, I'd like to
clone the device to a new disk. Can
I just do this with dd?

A

(Thanks to TheFu in the
Ubuntu Forums) Same here.
I'm doing a
sudo ddrescue --force
/dev/sdb /dev/sda
/tmp/log.file

Where sdb is the source, and
sda is the target.
This is backwards from what
most people would see. I swapped
the ports on purpose and powered
down/removed all other storage
(about 20TB) to prevent issues.
Using ddrescue is important
since it will continue AFTER errors
are seen.
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When all done, I'll restore the
backup from 3 days ago to fix any
failed sectors from the original.
Last time I looked, about 90MB of
errors were shown in the ddrescue
output.
That single command will
create all the formatting,
partitions, LVM stuff, everything.
At first reboot, I expect to have to
change the UUIDs for the
partitions. But since I'm still trying
to recover the last possible bits, I
cannot say for certain that my plan
will work.
ddrescue completed. Lots of
bad sectors, a few important, but
the system booted. boot, lvm,
partitions, and most data were all
handled as expected. The 2nd GPT
record was corrupted. Easily fixed.
Replicated the data from the
backup disk back over. Life is good.
Had a corrupt DB (it was a
media center), restore fixed that.
If the clone hadn't worked, I
would have followed my normal
restore processes for that
contents ^
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machine.
(From the Original Poster)
Happy to report that ddrescue did
the trick, although the drive did
not display any errors. I guess the
SMART warning was early enough
that the problematic sectors had
yet to be used. Plugged in the
replacement drive, ran
sudo ddrescue -f /dev/sda
/dev/sdb /tmp/mapfile

and waited for it to complete.
Swapped the cables and booted
successfully off the replica.
unable to mount the Win
Q 1I'm0 disks
in my PC when in

During startup, three error
Q messages
flash by too quickly
for me to write them down. How
can I get rid of them?

A

Use your phone to take a
video of the startup sequence.
Plug the exact text of a message
into Google, and you will probably
find your answer.

TOP QUESTIONS AT
ASKUBUNTU
* Making a PDF document
https://goo.gl/aLO4AG

Ubuntu. I get an error message
about an "unclean file system."

* What is the "Wanna Cry"
ransomware's possible impact on
Linux users?
https://goo.gl/GNHPgc

A

* How can I know from which
partition I had booted?
https://goo.gl/XC0A7G

Shutdown /s /t 0

* Does someone other than
Canonical provide paid support for
Ubuntu?
https://goo.gl/jTm9ct

(Thanks to kagashe in the
Ubuntu Forums) Shutdown
Windows using the following
command:

* Write the dynamic output of
terminal into a text file
full circle magazine #1 22

* Where do files rsynced to a host
go?
https://goo.gl/2P5bkt

thousands, even hundreds of
thousands of virtual machines
running. Then demand goes up a
little, and they need several
hundred more VMs -- right now.

* How to open two different files
using the vi editor?
https://goo.gl/5YgfpU

How quickly can the additional
VMs start serving clients? That is a
major competitive measurement.

* Purging a software package,
reinstalling it, it remembers
settings
https://goo.gl/4cZyTy

It's a different world from what
"we" experience -- you know,
people running a desktop or laptop
computer with Linux as the
operating system.

https://goo.gl/CfXKpw

* What would cause an installed
This is where we get into a lot
application to not be recognized as
of foreign terminology, such as
such?
Openstack, Docker, Vagrant,
https://goo.gl/pYHE8z
MAAS, LXD, containers, and system
images.

TIPS AND TECHNIQUES
What the big boys want

W

e all like a distro which
installs smoothly and
quickly, but for some people it's
essential.
Many large web sites run on ondemand servers, where they pay
based on the resources they use. A
large site might have hundreds,
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I haven't seen any benchmark
results, but speed of deployment
must be one of the factors helping
Ubuntu succeed in the cloud.

Gord had a long career in the

computer industry, then retired for
several years. More recently, he
somehow found himself "The IT Guy"
at a 1 5-person accounting firm in
downtown Toronto.
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V

Si ltbrea ker Act 1

Written by Oscar Rivera

alve has just released
Siltbreaker Act 1 which is a
new, story-driven, campaign-style,
action-adventure, co-op game. The
game was released on June 8, 201 7
and, although it was one week late,
it’s a welcome addition to my video
game library. It’s a tough game to
play, but in the couple of days I’ve
played it, it’s been a very
rewarding experience. The game is
actually more of a game within a
game as it is available for owners
of 201 7 Dota 2 The International
Battle Pass for the low price of
$9.99 which can be bought either
within Dota 2 or else separately
through Steam’s Battle Pass page
at
http://www.dota2.com/internation
al/battlepass. Siltbreaker, like Dota
2 is developed and released by
Valve, the company behind the
Steam game engine. Battle Pass
owners get a bunch of other items
besides Siltbreaker, and proceeds
from the sales of the Battle Pass
go toward the prize pool for this
year’s The International 201 7 event
which will be held in Seattle,
Washington from August 7th
through the 1 2th, 201 7. This year’s

Battle Pass is very similar to last
year’s, with a few changes, the
main change being the addition of
the Siltbreaker campaign game
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In typical Valve fashion, the
original release was delayed. The
game was scheduled to be
released sometime during May
201 7 but ended up being released
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in early June. After I got a Battle
Pass, I was disappointed that I
wouldn’t be able to review the
game in time for this month’s
magazine but, just in the nick of
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time, Siltbreaker was released.
My expectations were high and
the excitement was almost at
boiling point by the time the game
was released. It was a most
definite welcome sign when I
started Dota 2 on June 8 and
immediately there was a banner
informing me of Siltbreaker now
being available.
Upon starting Siltbreaker, a
digital comic book appears which
slowly tells of the tale behind
Siltbreaker concerning the
happenings in the Dark Reef. A left
mouse-click is required to cycle
through the comic book. The story
is pretty interesting and can be
read while you wait for the
network to match you up with a
team. Once your match begins, the
first thing you must do is select a
hero with which to play the game.
The game is limited to only 1 4
heroes out of the 1 1 0+ available in
a regular game of Dota 2. The 1 4
available heroes play very much
like they play in a regular game of
Dota 2. The items you build are the
same for the most part, except for
new items that are available only
in Siltbreaker. Leveling up your
hero is also similar to Dota 2... but
this is where the similarities end

and the differences begin. From
here on, Siltbreaker sits on a class
all of its own and feels & plays very
different from Dota 2.
For starters, you are teamed up
with three other players which
makes you belong to a team of
four instead of the standard 5v5 in
Dota 2; not to mention the fact
that you’re not playing against
other players but rather you’re
playing against the computer AI.
The campaign is rather hard to
beat, and will definitely require
you to run through it a few times
before being able to reach and
defeat the final boss Rhyzik.
You have to progress through
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different zones to beat the game.
The first couple of zones are not
too hard, but they introduce the
concept of the game and give you
an idea of what to expect. Unlike
Dota 2, the camera is not
controlled 1 00% by the player but
rather it moves with you as you
make your way through each zone.
As you explore each zone, you
encounter lots (and I do mean lots)
of foes along the way. In addition
to these enemies, some of the
zones have a mean, scary boss that
needs to be beat. Unfortunately
there are few guides available as
of now – because the game is so
new – but, by the time you read
this, I’m sure there will be more
than a handful of guides to help
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you along your way.
Some of the levels (or zones)
will have other obstacles besides
enemies – kind of like puzzles that
need to be timed properly to get
through. One of the unique
aspects of this game is that it
doesn’t allow you to save your
progress – which means it has to
be beat in one sitting or not at all.
So, for older gamers like me, this is
reminiscent of the old arcade
games when you put in a quarter
and played on that arcade machine
until your character died. In fact,
this almost reminds me of the
classic The Gauntlet video game.
Even if you don’t beat the game,
there is still benefit to be gained
from playing it as each zone will
award you anywhere from one to
three stars, depending on different
factors, as long as you perform
well. One star will give you 200
points toward your Battle Pass,
two stars will give you 400 points
toward the Battle Pass, and three
stars will give you a treasure which
will contain rare and hard-to-find
items that are available only
through this game.
The game is played with a
mouse & keyboard, and, depending
on which hero you select, the
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UBUNTU GAMES

actions for your key bindings will
differ. The graphics are
phenomenal but, at times, it
almost seems like there’s too much
action on the screen and it may
even feel a bit too clustered. The
surround sound is superb, and the
accompanying soundtrack is
deserving of an award. I have not
encountered any problems yet
with the game in the few days I’ve
been playing it except for Internet
lag from other players – which
once forced my team to pause a
couple of times to allow for the
player who had disconnected to reconnect. But I suppose that’s
something to be expected from coop multi-player online games
anyway.
I enjoyed playing Siltbreaker
very much. Perhaps my only
complaint about it is that there is
no tutorial at all. The only way to
learn how to play this game is to
just jump right in and start playing
it, which can be intimidating –
especially if you take into account
that other players with whom you
might be paired up are likely to get
annoyed with your mistakes due to
your lack of experience.
Siltbreaker Act 2: A Vault in the
Deep is due to be released in July
of this year. Unfortunately, it

seems like Siltbreaker will be a
limited edition game that will
vanish shortly after the completion
of The International 201 7, which
may be sometime in September
201 7. Then again, if Valve has
enough positive feedback from
gamers, there is a small chance
that this game might live to see
another day beyond its expiration
date. Not having released any new
content in quite a while (fans are
still waiting for Half-Life 3), it
wouldn’t be a bad idea for Valve to
give Siltbreaker the chance to stick

around for a while. Although I’ve
really enjoyed playing Siltbreaker,
the fact that it will most likely go
away in a few months and the lack
of any sort of tutorial makes me
deduct a whole star from my
rating.

Minimum Requirements
Operating System: Ubuntu 1 2.04 or
newer
CPU: Dual core from Intel or AMD
at 2.8 GHz
RAM: 4 GB
GPU: Nvidia GeForce 8600/9600GT
(Driver version 331 or newer), AMD
HD 2xxx-4xxx (Driver mesa 1 0.5.9),
Intel HD 3000 (Driver mesa 1 0.6)
Hard Drive: 1 6 GB available space
Additional Notes: Broadband
Internet connection

Oscar graduated with a music degree
from CSUN, is a Music
Director/Teacher, software/hardware
beta tester, Wikipedia editor, and
active member of the Ubuntu
community. You can email him at:
7bluehand@gmail.com
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MY D ESKTO P

MY D ESKTO P

Written by The_LinuxGK

U

buntu Mate 1 6.1 0 Ambiant
Mate / Humanity Icon Set (in
Greek language), with
transparency on the bars

Have a nice day!

Wallpaper:
http://www.wallpapermania.eu/wa
llpaper/funny-little-squirrel-withalmonds-hd-animal-wallpaper
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Written by David

I

'm using Ubuntu (1 6.04) but with
a pretty standard desktop.
Below you'll find Docky and I have
hidden the Unity bar. I like this
background pic that I found on the
internet, so took that one.
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MY D ESKTO P

Written by Vince

I

am currently using Elementary
OS 0.4 Loki (64 bit). I am a big
enthusiast of Linux and I have been
using Ubuntu for several years, but
some time ago I discovered
elementary OS. Its simplicity and
nice look and feel made me give it
a try.

(https://www.insynchq.com) at the
top of the screen.
My theme is basic "Elementary"
and it is improved by a very
beautiful set of icons called "Sardi"
(https://github.com/erikdubois/Sar
di)

As you can see, I like a look and
feel very clean and relaxed with
just a few indicators – (MyWeather-Indicator and SystemMonitor-Indicator) and the Insync
application for Google drive

Written by Siddharth Sundaresan

I

have a HP 630, which originally
came with Windows 7, an
operating system I had used for 2.5
years. I switched to Ubuntu 1 4.04
Unity in `1 5, which was my first
introduction to any form of Linux.
Since then, I have experimented
with many distributions and have a
folder containing ~1 20 gigs of ISOs
for live booting....
Display: 1 366 * 768 HD
Processor: Intel Core i3 @ 2.40 GHz * 4
RAM: 4 GB
HDD: 320 GB Internal Hard Drive + 1 TB
Sandisk External HDD
Graphics: Intel IronLake mobile
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All my drivers, including
wireless, processor and
multimedia keys are supported
perfectly in all the distributions
I`ve tested so far.
Operating System: Ubuntu
1 4.04, with Unity, GNOME (with
PixelSaver extension, as seen in
the screenshots), XFCE and KDE4
on the Internal Hard disk.
OpenSUSE GNOME Next on
External HDD. Fedora 26 Alpha on
a flash drive. feren OS for testing,
and possibly reviewing...
contents ^

PATRO N S
M ONTHLY PATRONS
201 6:

Bill Berninghausen
Jack McMahon
Linda P
Remke Schuurmans
Norman Phillips
Tom Rausner
Charles Battersby
Tom Bell
Oscar Rivera
Alex Crabtree
Ray Spain
Richard Underwood
Charles Anderson
Ricardo Coalla
Chris Giltnane
William von Hagen
Mark Shuttleworth
Juan Ortiz
Joe Gulizia
Kevin Raulins
Doug Bruce
Pekka Niemi
Rob Fitzgerald
Brian M Murray
Roy Milner
Brian Bogdan
Scott Mack
Dennis Mack
John Helmers

JT
Elizabeth K. Joseph
Vincent Jobard
Chris Giltnane
Joao Cantinho Lopes
John Andrews

201 7:

SINGLE D ONATIONS
201 6:

John Niendorf
Daniel Witzel
Douglas Brown
Donald Altman
Patrick Scango
Tony Wood
Paul Miller
Colin McCubbin
Randy Brinson
John Fromm
Graham Driver
Chris Burmajster
Steven McKee
Manuel Rey Garcia
Alejandro Carmona Ligeon
siniša vidović
Glenn Heaton
Louis W Adams Jr
Raul Thomas
Pascal Lemaitre
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PONG Wai Hing
Denis Millar
Elio Crivello
Rene Hogan
Kevin Potter
Marcos Alvarez Costales
Raymond Mccarthy
Max Catterwell
Frank Dinger
Paul Weed
Jaideep Tibrewala
Patrick Martindale
Antonino Ruggiero
Andrew Taylor

201 7:

Linda Prinsen
Shashank Sharma
Glenn Heaton
Frank Dinger
Randy E. Brinson

The current site was created thanks to
Lucas Westermann (Mr. Command &
Conquer) who took on the task of
completely rebuilding the site, and
scripts, from scratch, in his own time.
The Patreon page is to help pay the
domain and hosting fees. The yearly
target was quickly reached thanks to
those listed on this page. The money
also helps with the new mailing list that
I set up.
Several people have asked for a PayPal
(single donation) option, so I’ve added a
button to the right side of the website

A big thank you to all those who’ve
used Patreon and the PayPal button.
It’s a HUGE help.

https://www.patreon.com/
fullcirclemagazine

https://paypal.me/ronnietucker
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Full Circle Team

H OW TO CO N TRI BU TE

Editor - Ronnie Tucker
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FULL CIRCLE NEEDS YOU!

A magazine isn't a magazine without articles and Full Circle is no
exception. We need your opinions, desktops, stories, how-to's,
reviews, and anything else you want to tell your fellow *buntu users.
Send your articles to: articles@fullcirclemagazine.org

Deadline :

Sunday 09th July 201 7.
Release :
Friday 28th July 201 7.

We are always looking for new articles to include in Full Circle. For help and advice
please see the Official Full Circle Style Guide : http://url.fullcirclemagazine.org/75d471
Send your comments or Linux experiences to: letters@fullcirclemagazine.org
Hardware/software reviews should be sent to: reviews@fullcirclemagazine.org
Questions for Q&A should go to: questions@fullcirclemagazine.org
Desktop screens should be emailed to: misc@fullcirclemagazine.org
... or you can visit our site via: fullcirclemagazine.org

For the Full Circle Weekly News:

Webmaster - Lucas Westermann
admin@fullcirclemagazine.org

Editing & Proofreading

Mike Kennedy, Gord Campbell, Robert
Orsino, Josh Hertel, Bert Jerred, Jim
Dyer and Emily Gonyer
Our thanks go to Canonical, the many
translation teams around the world
and Thorsten Wilms for the FCM logo.

Getting Full Circle Magazine:
EPUB Format - Most editions have a link to the epub file

on that issues download page. If you have any problems
with the epub file, email: mobile@fullcirclemagazine.org

You can keep up to date with the Weekly News using the RSS
feed: http://fullcirclemagazine.org/feed/podcast

Issuu - You can read Full Circle online via Issuu:

Or, if your out and about, you can get the Weekly News via
Stitcher Radio (Android/iOS/web):
http://www.stitcher.com/s?fid=85347&refid=stpr
and via TuneIn at: http://tunein.com/radio/Full-Circle-WeeklyNews-p855064/
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ronnie@fullcirclemagazine.org

http://issuu.com/fullcirclemagazine. Please share and rate
FCM as it helps to spread the word about FCM and Ubuntu.

Magzster - You can also read Full Circle online via

Magzster: http://www.magzter.com/publishers/Full-Circle.
Please share and rate FCM as it helps to spread the word
about FCM and Ubuntu Linux.
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